	assignment
	business plan
	essay writing
	homework
	paper writing
	review writing




paper writing
business plan theory pdf

Share on FacebookShare on Twitter




	school Campus Bookshelves
	menu_book Bookshelves
	perm_media Learning Objects
	login Login
	how_to_reg Request Instructor Account
	hub Instructor Commons
	Download Page (PDF)
	Download Full Book (PDF)
	Periodic Table
	Physics Constants
	Scientific Calculator
	Reference & Cite
	Tools expand_more
	Readability

selected template will load here
This action is not available.


1.1: Chapter 1 – Developing a Business Plan
	Last updated
	Save as PDF
	Page ID 21274


	Lee A. Swanson
	University of Saskatchewan

Learning Objectives
After completing this chapter, you will be able to
	Describe the purposes for business planning
	Describe common business planning principles
	Explain common business plan development guidelines and tools
	List and explain the elements of the business plan development process
	Explain the purposes of each element of the business plan development process
	Explain how applying the business plan development process can aid in developing a business plan that will meet entrepreneurs’ goals

This chapter describes the purposes, principles, and the general concepts and tools for business planning, and the process for developing a business plan.
Purposes for Developing Business Plans
Business plans are developed for both internal and external purposes. Internally, entrepreneurs develop business plans to help put the pieces of their business together. Externally, the most common purpose is to raise capital.
Internal Purposes
As the road map for a business’s development, the business plan
	Defines the vision for the company
	Establishes the company’s strategy
	Describes how the strategy will be implemented
	Provides a framework for analysis of key issues
	Provides a plan for the development of the business
	Helps the entrepreneur develop and measure critical success factors
	Helps the entrepreneur to be realistic and test theories

External Purposes
The business plan provides the most complete source of information for valuation of the business. Thus, it is often the main method of describing a company to external audiences such as potential sources for financing and key personnel being recruited. It should assist outside parties to understand the current status of the company, its opportunities, and its needs for resources such as capital and personnel.
Business Plan Development Principles
Hindle and Mainprize (2006) suggested that business plan writers must strive to effectively communicate their expectations about the nature of an uncertain future and to project credibility. The liabilities of newness make communicating the expected future of new ventures much more difficult than for existing businesses. Consequently, business plan writers should adhere to five specific communication principles .
First, business plans must be written to meet the expectations of targeted readers in terms of what they need to know to support the proposed business. They should also lay out the milestones that investors or other targeted readers need to know. Finally, writers must clearly outline the opportunity , the context within the proposed venture will operate (internal and external environment), and the business model (Hindle & Mainprize, 2006).
There are also five business plan credibility principles that writers should consider. Business plan writers should build and establish their credibility by highlighting important and relevant information about the venture team . Writers need to elaborate on the plans they outline in their document so that targeted readers have the information they need to assess the plan’s credibility. To build and establish credibility, they must integrate scenarios to show that the entrepreneur has made realistic assumptions and has effectively anticipated what the future holds for their proposed venture. Writers need to provide comprehensive and realistic financial links between all relevant components of the plan. Finally, they must outline the deal , or the value that targeted readers should expect to derive from their involvement with the venture (Hindle & Mainprize, 2006).
General Guidelines for Developing Business Plans
Many businesses must have a business plan to achieve their goals. Using a standard format helps the reader understand that the you have thought everything through, and that the returns justify the risk. The following are some basic guidelines for business plan development.
As You Write Your Business Plan
1. If appropriate, include nice, catchy, professional graphics on your title page to make it appealing to targeted readers, but don’t go overboard.
2. Bind your document so readers can go through it easily without it falling apart. You might use a three-ring binder, coil binding, or a similar method. Make sure the binding method you use does not obscure the information next to where it is bound.
3. Make certain all of your pages are ordered and numbered correctly.
4. The usual business plan convention is to number all major sections and subsections within your plan using the format as follows:
1. First main heading
1.1 First subheading under the first main heading
1.1.1. First sub-subheading under the first subheading
2. Second main heading
2.1 First subheading under the second main heading
Use the styles and references features in Word to automatically number and format your section titles and to generate your table of contents. Be sure that the last thing you do before printing your document is update your automatic numbering and automatically generated tables. If you fail to do this, your numbering may be incorrect.
5. Prior to submitting your plan, be 100% certain each of the following requirements are met:
	Everything must be completely integrated. The written part must say exactly the same thing as the financial part.
	All financial statements must be completely linked and valid. Make sure all of your balance sheets balance.
	Everything must be correct. There should be NO spelling, grammar, sentence structure, referencing, or calculation errors.
	Your document must be well organized and formatted. The layout you choose should make the document easy to read and comprehend. All of your diagrams, charts, statements, and other additions should be easy to find and be located in the parts of the plan best suited to them.
	In some cases it can strengthen your business plan to show some information in both text and table or figure formats. You should avoid unnecessary repetition , however, as it is usually unnecessary—and even damaging—to state the same thing more than once.
	You should include all the information necessary for readers to understand everything in your document.
	The terms you use in your plan should be clear and consistent. For example, the following statement in a business plan would leave a reader completely confused: “There is a shortage of 100,000 units with competitors currently producing 25,000. We can help fill this huge gap in demand with our capacity to produce 5,000 units.”
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Learning Objectives
By the end of this section, you will be able to:
	Describe the different purposes of a business plan
	Describe and develop the components of a brief business plan
	Describe and develop the components of a full business plan

Unlike the brief or lean formats introduced so far, the business plan is a formal document used for the long-range planning of a company’s operation. It typically includes background information, financial information, and a summary of the business. Investors nearly always request a formal business plan because it is an integral part of their evaluation of whether to invest in a company. Although nothing in business is permanent, a business plan typically has components that are more “set in stone” than a business model canvas , which is more commonly used as a first step in the planning process and throughout the early stages of a nascent business. A business plan is likely to describe the business and industry, market strategies, sales potential, and competitive analysis, as well as the company’s long-term goals and objectives. An in-depth formal business plan would follow at later stages after various iterations to business model canvases. The business plan usually projects financial data over a three-year period and is typically required by banks or other investors to secure funding. The business plan is a roadmap for the company to follow over multiple years.
Some entrepreneurs prefer to use the canvas process instead of the business plan, whereas others use a shorter version of the business plan, submitting it to investors after several iterations. There are also entrepreneurs who use the business plan earlier in the entrepreneurial process, either preceding or concurrently with a canvas. For instance, Chris Guillebeau has a one-page business plan template in his book The $100 Startup . 48 His version is basically an extension of a napkin sketch without the detail of a full business plan. As you progress, you can also consider a brief business plan (about two pages)—if you want to support a rapid business launch—and/or a standard business plan.
As with many aspects of entrepreneurship, there are no clear hard and fast rules to achieving entrepreneurial success. You may encounter different people who want different things (canvas, summary, full business plan), and you also have flexibility in following whatever tool works best for you. Like the canvas, the various versions of the business plan are tools that will aid you in your entrepreneurial endeavor.
Business Plan Overview
Most business plans have several distinct sections ( Figure 11.16 ). The business plan can range from a few pages to twenty-five pages or more, depending on the purpose and the intended audience. For our discussion, we’ll describe a brief business plan and a standard business plan. If you are able to successfully design a business model canvas, then you will have the structure for developing a clear business plan that you can submit for financial consideration.
Both types of business plans aim at providing a picture and roadmap to follow from conception to creation. If you opt for the brief business plan, you will focus primarily on articulating a big-picture overview of your business concept.
The full business plan is aimed at executing the vision concept, dealing with the proverbial devil in the details. Developing a full business plan will assist those of you who need a more detailed and structured roadmap, or those of you with little to no background in business. The business planning process includes the business model, a feasibility analysis, and a full business plan, which we will discuss later in this section. Next, we explore how a business plan can meet several different needs.
Purposes of a Business Plan
A business plan can serve many different purposes—some internal, others external. As we discussed previously, you can use a business plan as an internal early planning device, an extension of a napkin sketch, and as a follow-up to one of the canvas tools. A business plan can be an organizational roadmap , that is, an internal planning tool and working plan that you can apply to your business in order to reach your desired goals over the course of several years. The business plan should be written by the owners of the venture, since it forces a firsthand examination of the business operations and allows them to focus on areas that need improvement.
Refer to the business venture throughout the document. Generally speaking, a business plan should not be written in the first person.
A major external purpose for the business plan is as an investment tool that outlines financial projections, becoming a document designed to attract investors. In many instances, a business plan can complement a formal investor’s pitch. In this context, the business plan is a presentation plan, intended for an outside audience that may or may not be familiar with your industry, your business, and your competitors.
You can also use your business plan as a contingency plan by outlining some “what-if” scenarios and exploring how you might respond if these scenarios unfold. Pretty Young Professional launched in November 2010 as an online resource to guide an emerging generation of female leaders. The site focused on recent female college graduates and current students searching for professional roles and those in their first professional roles. It was founded by four friends who were coworkers at the global consultancy firm McKinsey. But after positions and equity were decided among them, fundamental differences of opinion about the direction of the business emerged between two factions, according to the cofounder and former CEO Kathryn Minshew . “I think, naively, we assumed that if we kicked the can down the road on some of those things, we’d be able to sort them out,” Minshew said. Minshew went on to found a different professional site, The Muse , and took much of the editorial team of Pretty Young Professional with her. 49 Whereas greater planning potentially could have prevented the early demise of Pretty Young Professional, a change in planning led to overnight success for Joshua Esnard and The Cut Buddy team. Esnard invented and patented the plastic hair template that he was selling online out of his Fort Lauderdale garage while working a full-time job at Broward College and running a side business. Esnard had hundreds of boxes of Cut Buddies sitting in his home when he changed his marketing plan to enlist companies specializing in making videos go viral. It worked so well that a promotional video for the product garnered 8 million views in hours. The Cut Buddy sold over 4,000 products in a few hours when Esnard only had hundreds remaining. Demand greatly exceeded his supply, so Esnard had to scramble to increase manufacturing and offered customers two-for-one deals to make up for delays. This led to selling 55,000 units, generating $700,000 in sales in 2017. 50 After appearing on Shark Tank and landing a deal with Daymond John that gave the “shark” a 20-percent equity stake in return for $300,000, The Cut Buddy has added new distribution channels to include retail sales along with online commerce. Changing one aspect of a business plan—the marketing plan—yielded success for The Cut Buddy.
Link to Learning
Watch this video of Cut Buddy’s founder, Joshua Esnard, telling his company’s story to learn more.
If you opt for the brief business plan, you will focus primarily on articulating a big-picture overview of your business concept. This version is used to interest potential investors, employees, and other stakeholders, and will include a financial summary “box,” but it must have a disclaimer, and the founder/entrepreneur may need to have the people who receive it sign a nondisclosure agreement (NDA) . The full business plan is aimed at executing the vision concept, providing supporting details, and would be required by financial institutions and others as they formally become stakeholders in the venture. Both are aimed at providing a picture and roadmap to go from conception to creation.
Types of Business Plans
The brief business plan is similar to an extended executive summary from the full business plan. This concise document provides a broad overview of your entrepreneurial concept, your team members, how and why you will execute on your plans, and why you are the ones to do so. You can think of a brief business plan as a scene setter or—since we began this chapter with a film reference—as a trailer to the full movie. The brief business plan is the commercial equivalent to a trailer for Field of Dreams , whereas the full plan is the full-length movie equivalent.
Brief Business Plan or Executive Summary
As the name implies, the brief business plan or executive summary summarizes key elements of the entire business plan, such as the business concept, financial features, and current business position. The executive summary version of the business plan is your opportunity to broadly articulate the overall concept and vision of the company for yourself, for prospective investors, and for current and future employees.
A typical executive summary is generally no longer than a page, but because the brief business plan is essentially an extended executive summary, the executive summary section is vital. This is the “ask” to an investor. You should begin by clearly stating what you are asking for in the summary.
In the business concept phase, you’ll describe the business, its product, and its markets. Describe the customer segment it serves and why your company will hold a competitive advantage. This section may align roughly with the customer segments and value-proposition segments of a canvas.
Next, highlight the important financial features, including sales, profits, cash flows, and return on investment. Like the financial portion of a feasibility analysis, the financial analysis component of a business plan may typically include items like a twelve-month profit and loss projection, a three- or four-year profit and loss projection, a cash-flow projection, a projected balance sheet, and a breakeven calculation. You can explore a feasibility study and financial projections in more depth in the formal business plan. Here, you want to focus on the big picture of your numbers and what they mean.
The current business position section can furnish relevant information about you and your team members and the company at large. This is your opportunity to tell the story of how you formed the company, to describe its legal status (form of operation), and to list the principal players. In one part of the extended executive summary, you can cover your reasons for starting the business: Here is an opportunity to clearly define the needs you think you can meet and perhaps get into the pains and gains of customers. You also can provide a summary of the overall strategic direction in which you intend to take the company. Describe the company’s mission, vision, goals and objectives, overall business model, and value proposition.
Rice University’s Student Business Plan Competition, one of the largest and overall best-regarded graduate school business-plan competitions (see Telling Your Entrepreneurial Story and Pitching the Idea ), requires an executive summary of up to five pages to apply. 51 , 52 Its suggested sections are shown in Table 11.2 .
Are You Ready?
Create a brief business plan.
Fill out a canvas of your choosing for a well-known startup: Uber, Netflix, Dropbox, Etsy, Airbnb, Bird/Lime, Warby Parker, or any of the companies featured throughout this chapter or one of your choice. Then create a brief business plan for that business. See if you can find a version of the company’s actual executive summary, business plan, or canvas. Compare and contrast your vision with what the company has articulated.
	These companies are well established but is there a component of what you charted that you would advise the company to change to ensure future viability?
	Map out a contingency plan for a “what-if” scenario if one key aspect of the company or the environment it operates in were drastically is altered?

Full Business Plan
Even full business plans can vary in length, scale, and scope. Rice University sets a ten-page cap on business plans submitted for the full competition. The IndUS Entrepreneurs , one of the largest global networks of entrepreneurs, also holds business plan competitions for students through its Tie Young Entrepreneurs program. In contrast, business plans submitted for that competition can usually be up to twenty-five pages. These are just two examples. Some components may differ slightly; common elements are typically found in a formal business plan outline. The next section will provide sample components of a full business plan for a fictional business.
Executive Summary
The executive summary should provide an overview of your business with key points and issues. Because the summary is intended to summarize the entire document, it is most helpful to write this section last, even though it comes first in sequence. The writing in this section should be especially concise. Readers should be able to understand your needs and capabilities at first glance. The section should tell the reader what you want and your “ask” should be explicitly stated in the summary.
Describe your business, its product or service, and the intended customers. Explain what will be sold, who it will be sold to, and what competitive advantages the business has. Table 11.3 shows a sample executive summary for the fictional company La Vida Lola.
Business Description
This section describes the industry, your product, and the business and success factors. It should provide a current outlook as well as future trends and developments. You also should address your company’s mission, vision, goals, and objectives. Summarize your overall strategic direction, your reasons for starting the business, a description of your products and services, your business model, and your company’s value proposition. Consider including the Standard Industrial Classification/North American Industry Classification System (SIC/NAICS) code to specify the industry and insure correct identification. The industry extends beyond where the business is located and operates, and should include national and global dynamics. Table 11.4 shows a sample business description for La Vida Lola.
Industry Analysis and Market Strategies
Here you should define your market in terms of size, structure, growth prospects, trends, and sales potential. You’ll want to include your TAM and forecast the SAM . (Both these terms are discussed in Conducting a Feasibility Analysis .) This is a place to address market segmentation strategies by geography, customer attributes, or product orientation. Describe your positioning relative to your competitors’ in terms of pricing, distribution, promotion plan, and sales potential. Table 11.5 shows an example industry analysis and market strategy for La Vida Lola.
Competitive Analysis
The competitive analysis is a statement of the business strategy as it relates to the competition. You want to be able to identify who are your major competitors and assess what are their market shares, markets served, strategies employed, and expected response to entry? You likely want to conduct a classic SWOT analysis (Strengths Weaknesses Opportunities Threats) and complete a competitive-strength grid or competitive matrix. Outline your company’s competitive strengths relative to those of the competition in regard to product, distribution, pricing, promotion, and advertising. What are your company’s competitive advantages and their likely impacts on its success? The key is to construct it properly for the relevant features/benefits (by weight, according to customers) and how the startup compares to incumbents. The competitive matrix should show clearly how and why the startup has a clear (if not currently measurable) competitive advantage. Some common features in the example include price, benefits, quality, type of features, locations, and distribution/sales. Sample templates are shown in Figure 11.17 and Figure 11.18 . A competitive analysis helps you create a marketing strategy that will identify assets or skills that your competitors are lacking so you can plan to fill those gaps, giving you a distinct competitive advantage. When creating a competitor analysis, it is important to focus on the key features and elements that matter to customers, rather than focusing too heavily on the entrepreneur’s idea and desires.
Operations and Management Plan
In this section, outline how you will manage your company. Describe its organizational structure. Here you can address the form of ownership and, if warranted, include an organizational chart/structure. Highlight the backgrounds, experiences, qualifications, areas of expertise, and roles of members of the management team. This is also the place to mention any other stakeholders, such as a board of directors or advisory board(s), and their relevant relationship to the founder, experience and value to help make the venture successful, and professional service firms providing management support, such as accounting services and legal counsel.
Table 11.6 shows a sample operations and management plan for La Vida Lola.
Marketing Plan
Here you should outline and describe an effective overall marketing strategy for your venture, providing details regarding pricing, promotion, advertising, distribution, media usage, public relations, and a digital presence. Fully describe your sales management plan and the composition of your sales force, along with a comprehensive and detailed budget for the marketing plan. Table 11.7 shows a sample marketing plan for La Vida Lola.
Financial Plan
A financial plan seeks to forecast revenue and expenses; project a financial narrative; and estimate project costs, valuations, and cash flow projections. This section should present an accurate, realistic, and achievable financial plan for your venture (see Entrepreneurial Finance and Accounting for detailed discussions about conducting these projections). Include sales forecasts and income projections, pro forma financial statements ( Building the Entrepreneurial Dream Team , a breakeven analysis, and a capital budget. Identify your possible sources of financing (discussed in Conducting a Feasibility Analysis ). Figure 11.19 shows a template of cash-flow needs for La Vida Lola.
Entrepreneur In Action
Laughing man coffee.
Hugh Jackman ( Figure 11.20 ) may best be known for portraying a comic-book superhero who used his mutant abilities to protect the world from villains. But the Wolverine actor is also working to make the planet a better place for real, not through adamantium claws but through social entrepreneurship.
A love of java jolted Jackman into action in 2009, when he traveled to Ethiopia with a Christian humanitarian group to shoot a documentary about the impact of fair-trade certification on coffee growers there. He decided to launch a business and follow in the footsteps of the late Paul Newman, another famous actor turned philanthropist via food ventures.
Jackman launched Laughing Man Coffee two years later; he sold the line to Keurig in 2015. One Laughing Man Coffee café in New York continues to operate independently, investing its proceeds into charitable programs that support better housing, health, and educational initiatives within fair-trade farming communities. 55 Although the New York location is the only café, the coffee brand is still distributed, with Keurig donating an undisclosed portion of Laughing Man proceeds to those causes (whereas Jackman donates all his profits). The company initially donated its profits to World Vision, the Christian humanitarian group Jackman accompanied in 2009. In 2017, it created the Laughing Man Foundation to be more active with its money management and distribution.
	You be the entrepreneur. If you were Jackman, would you have sold the company to Keurig? Why or why not?
	Would you have started the Laughing Man Foundation?
	What else can Jackman do to aid fair-trade practices for coffee growers?

What Can You Do?
Textbooks for change.
Founded in 2014, Textbooks for Change uses a cross-compensation model, in which one customer segment pays for a product or service, and the profit from that revenue is used to provide the same product or service to another, underserved segment. Textbooks for Change partners with student organizations to collect used college textbooks, some of which are re-sold while others are donated to students in need at underserved universities across the globe. The organization has reused or recycled 250,000 textbooks, providing 220,000 students with access through seven campus partners in East Africa. This B-corp social enterprise tackles a problem and offers a solution that is directly relevant to college students like yourself. Have you observed a problem on your college campus or other campuses that is not being served properly? Could it result in a social enterprise?
Work It Out
Franchisee set out.
A franchisee of East Coast Wings, a chain with dozens of restaurants in the United States, has decided to part ways with the chain. The new store will feature the same basic sports-bar-and-restaurant concept and serve the same basic foods: chicken wings, burgers, sandwiches, and the like. The new restaurant can’t rely on the same distributors and suppliers. A new business plan is needed.
	What steps should the new restaurant take to create a new business plan?
	Should it attempt to serve the same customers? Why or why not?

This New York Times video, “An Unlikely Business Plan,” describes entrepreneurial resurgence in Detroit, Michigan.
	48 Chris Guillebeau. The $100 Startup: Reinvent the Way You Make a Living, Do What You Love, and Create a New Future . New York: Crown Business/Random House, 2012.
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Introduction
No business plan survives first contact with a customer – Steve Blank
This quote represents the differing perspectives on the value of business planning relative to the value of lean startup methods proposed by Blank and others ( Blank and Dorf, 2012 ). Much of traditional entrepreneurial training centers on the business plan ( Honig, 2004 ). Collective research on business planning's antecedents ( Brinckmann et al. , 2019 ) and its performance outcomes have found nuanced results ( Brinckmann et al. , 2010 ), but there seem to be at least some instances where business planning reliably increases performance ( Welter and Kim, 2018 ). Studies suggest that the majority of prominent business schools offer business planning courses ( Honig, 2004 ; Katz et al. , 2016 ), and bookstores are filled with books detailing how to write a business plan ( Karlsson and Honig, 2007 ). Nonetheless, the research is fragmented at best, and often results in equivocal findings with regard to its relationship with firm performance ( Brinckmann et al. , 2010 , Delmar and Shane, 2003 ; Gruber, 2007 ). This lack of clear indication from researchers opens the door for critique of business planning from proponents of the lean startup ( Ghezzi et al. , 2015 ).
Lean startup methods have drawn increasing attention in entrepreneurial communities ( Ries, 2011 ). In accelerators, incubators and other spaces within startup ecosystems the wisdom of Eric Ries (2011) and Steve Blank ( Blank and Dorf, 2012 ) can be heard in training sessions and everyday conversations. Some entrepreneurial programs have adopted lean startup methods as well ( Bliemel, 2014 ). On one hand, conceptual articles have described how lean startup fits adjacent to current and past academic conversations ( Contigiani and Levinthal, 2019 ). On the other hand, practitioner articles have discussed the benefits and limitations of the models ( Ladd, 2016 ). In both cases, existing literature describes how these processes aim to avoid the pitfall of launching products that no one actually wants ( Blank, 2013 ).
Despite all the popular attention given to lean startup methods, little empirical research has been completed (see Trimi and Berbegal-Mirabent (2012) , Ghezzi et al. (2015) , and Ghezzi (2019) for exceptions). Some researchers (e.g. Frederickson and Brem, 2017 ) have drawn the parallels between lean startup methods and effectuation ( Sarasvathy, 2001 ), but these parallels do not sufficiently support the use of lean startup methods. While practitioners seem to embrace lean startup methods, academics have offered little in terms of direct investigation into those methods ( Shepherd and Gruber, 2020 ). Most of the research on lean startup methods focuses on cognitive processes ( Yang et al. , 2018 ; York and Danes, 2014 ). Recent critique ( Felin et al. , 2019 ) coupled with the dearth of empirical research calls into question the efficacy of lean startup methods. To that end, more research is needed to see how lean startup methods relate to new venture success especially in comparison to business planning. This is particularly important as new venture formation activities are the practices that can legitimize the firm ( De Clercq and Voronov, 2009 ).
As such, we propose the following question: which individual aspects of business planning and lean startup methods are related to success? We study the components of both business planning and lean startup methods as there is some academic support for aspects of lean startup such as experimentation ( Carmuffo et al. , 2019 ), but limited empirical investigation into lean startup more broadly. We specifically focus on the underlying activities that make up the processes of lean startup and business planning since our initial surveying showed that entrepreneurs often employ aspects of each. To examine this question, we created a survey that captured the various activities – both from lean startup and business planning – that entrepreneurs used in pursuing their new venture and compared those with measures of success.
Our findings suggest that certain lean startup activities and the act of writing a business plan are correlated with success. These findings help to undo a false dichotomy of either lean startup or business planning by suggesting that some activities from each side can lead to success. We contribute to business planning research by offering a possible explanation for the existing equivocal findings. Namely, that the act of writing a business plan may be important, but that the uses of a business plan for feedback or financing are not necessarily associated with success. We contribute to research on lean startup by offering the first quantitative support for specific lean startup activities. Taken together, this research lays the foundation for a more nuanced understanding of the value of business planning and lean startup methods.
Theoretical framework and hypotheses
The literature on business planning is vast focusing on both antecedents to business planning ( Brinckmann et al. , 2019 ) and outcomes of it ( Brinckmann et al. , 2010 ). Honig and colleagues have driven much of the research into business planning since the turn of the century ( Honig, 2004 ; Honig and Karlsson, 2004 ; Honig and Samuelsson, 2012 , 2014 ; Karlsson and Honig, 2009 ). They have challenged prior planning-performance paradigms that suggested planning would naturally increase performance ( Ajzen, 1985 ; Mintzberg and Waters, 1985 ; Ansoff, 1991 ). This debate about the value of planning has underscored the recent research into selection effects associated with business planning ( Burke et al. , 2010 ; Greene and Hopp, 2017 ).
Brinckmann et al. (2010) address this debate directly. Their meta-analytic review of business planning literature suggests that three contingencies need to be considered in terms of the effectiveness of business planning: uncertainty, limited prior information, and the lack of business planning structures. The presence of these three suggest that business planning may be less effective. We look at each of these three contingencies in more depth next.
For uncertainty, planning scholars (e.g. Priem et al. , 1995 ) suggest that unstable and uncertain environments would benefit most from planning as planning can reduce uncertainty through facilitating faster decision-making ( Dean and Sharfman, 1996 ). However, emergent strategies seem to be more effective at controlling uncertainty ( Mintzberg, 1994 ; Sarasvathy, 2001 ). Brinckmann et al. (2010) confirms the latter intuition suggesting that uncertainty makes planning efforts less effective. This logic falls in line with research on effectuation ( Sarasvathy, 2001 ), where planning is described as the appropriate strategy for risky environments and effectuation, in contrast, is appropriate for uncertain environments. Recent work has confirmed this logic depending on how accurate the entrepreneur can be when predicting the future ( Welter and Kim, 2018 ).
Turning to the concept of limited prior information, planning proponents suggest that the shorter feedback cycles in new and small firms combined with the positive motivational effects of planning will make it more effective ( Delmar and Shane, 2003 ). In essence, despite the lack of history for de novo firms, short cycle times create history quickly and planning itself serves to motivate these fledgling organizations. However, Brinckmann et al. (2010) find that these firms lack the information necessary to make such plans effective. As firms pursue novel strategies, planning seems to be less effective or firms abandon plans all together as they move forward ( Karlsson and Honig, 2009 ).
Finally, for plans to be effective firms need to have the structures in place to both plan and make use of those plans ( Brinckmann et al. , 2010 ). New firms tend to lack the organizational structures relevant to create and use plans ( Forbes, 2007 ). While Karlsson and Honig (2009) found that firms typically ignore or abandon plans after they have been made, often due to insufficient support structures, Honig and Samuelsson (2012) show that even when firms change their plans over time there is little impact on firm performance. In general, the literature on business planning suggests that planning has more benefits for established firms with data and history to support both the plan and the planning process.
Business planning activities improve the likelihood of success for new ventures.
Typically, business planning has been analyzed as the single act of writing a business plan (e.g. Honig and Karlsson, 2004 ). However, business planning is made up of a variety of activities ( Gruber, 2007 ), which entrepreneurs may utilize as a whole, or simply choose parts of the business planning process. It is worth noting that these specific activities are not mutually exclusive with lean startup activities that we will detail later. One source of the gap between the prevalence of business planning use and research supporting the efficacy of business plans may be this holistic perspective. The constituent parts of business planning may be executed as a whole, or may be chosen a la carte. Examining the various activities that make up business planning offers insight into which aspects of the process are related to firm performance.
Arguably the first step in the business planning process is the work that precedes the actual writing of a business plan. First, entrepreneurs must collect data – typically external data ( Brinckmann et al. , 2010 ). This data collection process may or may not result in an actual business plan being written and, therefore, can be treated as a separate step itself.
Beyond the data collection and writing, the planning process can play a role in routinizing the initial practices of entrepreneurs. While entrepreneurs may engage in social resourcing ( Keating et al. , 2014 ) and collective sense-making ( Wood and McKinley, 2010 ), the act of codifying the results of these activities can objectify these practices. Entrepreneurs engage socially on a number of dimensions in the pursuit of a venture, but physically writing down a business plan that can be shared externally can serve as a commitment mechanism. Entrepreneurs may share this plan with external stakeholders simply for feedback ( Wood and McKinley, 2010 ) or they may use it to seek funding ( Richbell et al. , 2006 ).
Writing a business plan improves the likelihood of success for new ventures.
Gathering secondary data improves the likelihood of success for new ventures.
Sharing a business plan with potential stakeholders in order to get feedback improves the likelihood of success for new ventures.
Sharing a business plan with potential financiers in order to obtain funding improves the likelihood of success for new ventures.
Lean startup
The concept and the phrase “Lean Startup” stem from Eric Ries (2011) and his popular press book by the same name. The phrase borrows from the idea of lean manufacturing in the sense of eliminating waste and pushing production and supply as late in the process as possible to delay purchasing until the last moment. The book draws primarily on Ries's personal experience in founding a company along with some consulting work. Further development of the ideas around lean startup methods comes from Steve Blank ( Blank and Dorf, 2012 ). Blank (2013) described three principles of lean startup: hypothesis creation, customer development, and agile development. Hypothesis creation represents the belief that founders begin with little more than untested hypotheses. Customer development represents the approach of interviewing and interacting with customers in order to verify or discard the aforementioned hypotheses. Finally, agile development conceptualizes that minimally viable products (MVPs) are deployed quickly to verify the hypotheses that are believed to be true.
These concepts are often practiced by entrepreneurs and taught at incubators and accelerators ( Ladd, 2016 ), but there is little academic research to support these practices. Ghezzi et al. (2015) offer one of the only comparative empirical studies between lean startup and business planning. Their findings from a four-case study suggest that lean startup methods lead to superior outcomes. The majority of other papers are conceptual explorations of lean startup methods focusing on the decision-making of entrepreneurs ( Frederickson and Brem, 2017 ; Yang et al. , 2018 ; York and Danes, 2014 ). These conceptual pieces draw parallels between lean startup and effectuation ( Sarasvathy, 2001 ).
The literature on effectuation is much larger than that of lean startup (see recent reviews and retrospectives by Arend et al. (2015) and Reymen et al. (2015) ). Effectuation has been defined as entrepreneurial expertise that utilizes heuristics to make decisions focused on the means available rather than on desired ends ( Sarasvathy, 2001 ). One heuristic, in particular, has driven the comparison between lean startup and effectuation: experimentation ( Camuffo et al. , 2019 ). However, the comparisons may stem from the lack of clear boundaries in effectuation (see Welter et al. , 2016 ). While some researchers might argue that effectuation is a more robust articulation of lean startup ( Frederickson and Brem, 2017 ), there are significant departures. Effectuation makes no mention of MVPs or agile development, but instead focuses on the means at hand ( Sarasvathy and Dew, 2008 ). These means direct the venture as opposed to a focus on a specific end in mind ( Sarasvathy, 2001 ). This is in contrast to lean startup methods that create specific tests in order to verify a predetermined path ( Blank, 2013 ). Thus, researchers have suggested that lean startup intersects with effectuation, as well as other research streams ( Contigiani and Levinthal, 2019 ; Ghezzi, 2019 ).
Utilizing lean startup methods improves the likelihood of success for new business ventures.
Similar to business planning, lean startup is a process with several component parts from which an entrepreneur may select without needing to accomplish each task. Moreover, these component parts may be used in conjunction with business planning activities. Since lean startup has been developed more by practitioners than academics, there is not a clearly-defined, comprehensive list of activities that constitutes lean startup. Bortolini et al. (2018) review the academic and popular press literature on lean startup and describe the process at a more theoretical level than the work of Blank (2013) and Ries (2011) . Between these two perspectives, a specific list of six lean startup activities can be derived.
The lean startup process begins with customer discovery ( Blank and Dorf, 2012 ). In its most basic sense, the process of customer discovery begins with interviewing potential customers to surface their problems. Blank (2013) describes how lean startups “get out of the building” throughout the process to validate customer assumptions regarding all aspects of a potential business model. This validation process involves a variety of different forms of potential customer interviews.
From there, entrepreneurs craft hypotheses and build experiments as Bortolini et al. (2018) describe. This part of the process can be deconstructed into developing prototypes, showing those prototypes to customers, and running experiments. These sub-processes are discrete steps that may depend on each other, but may also occur independently. For instance, entrepreneurs may develop prototypes in their own quest to improve the product without actually showing a given prototype to potential customers. Alternatively, entrepreneurs may run experiments that do not necessarily involve the use of a prototype. These experiments may include observing customers in their daily routine to better understand customer problems. Each of these processes, however, align with the practitioner perspectives and the theoretical perspectives ( Blank and Dorf, 2012 ; Bortolini et al. , 2018) .
Beyond these specific activities, we examine two other activities within lean startup: collecting preorders and pivoting. Collecting preorders for new products has been suggested by Ries (2011) , but also aligns with research on enrolling external stakeholders ( Burns et al. , 2016 ) and the principles of effectuation ( Sarasvathy, 2001 ). By seeking out early stakeholders to make commitments like preorders or input on prototypes, entrepreneurs seek social resources to enable and direct their progress ( Keating et al. , 2014 ).
Interviewing potential customers improves the likelihood of success for new business ventures.
Developing a prototype improves the likelihood of success for new business ventures.
Showing a prototype to potential customers improves the likelihood of success for new business ventures.
Experimenting to test business model assumptions improves the likelihood of success for new business ventures.
Collecting preorders improves the likelihood of success for new business ventures.
Pivoting based on customer feedback improves the likelihood of success for new business ventures.
We began our study by conducting semi-structured interviews with five entrepreneurs to guide the construction of the survey. These entrepreneurs were selected from the authors' personal networks to represent a variety of perspectives and experiences. The group included two female founders and three male founders; two of the founders created high-tech scalable businesses and three represented small businesses. The interviews lasted 75 min on average.
All interviewees were familiar with business plans. All interviewees had heard of “lean startup” but only one entrepreneur had any education on the subject – they had read Eric Ries's book ( Ries, 2011 ). Nonetheless, none of the entrepreneurs could articulate specific aspects of lean startup or how it would be different from or related to writing a business plan.
The data collected from these interviews was used to develop a survey for distribution to a wider group of entrepreneurs. Within the qualitative data we noted how both business planning and lean startup represented groups of activities to the entrepreneurs. In discussing business planning, all of the entrepreneurs discussed more than simply producing a formal business plan. While four of the five entrepreneurs created formal business plans, each discussed a slightly different process. Some included financial planning while others mentioned secondary research. On the lean startup approach, the entrepreneurs did not specifically state which activities they pursued that were in line with lean startup, but multiple entrepreneurs mentioned each of the aspects of lean startup that we included in the survey.
This qualitative investigation altered our survey design to focus more on the activities that entrepreneurs completed rather than focusing on their understanding of the different approaches. Before distributing the survey, we tested it with two entrepreneurs to obtain feedback on its understandability – one from the original interviewees and one unfamiliar with the research project. Based on these tests, minor modifications to word choice were made.
We reached out to the startup ecosystem in a major Midwestern city. The online survey was emailed to incubators, accelerators, individual entrepreneurs, and organizations that reach outside the Midwest. Participation in the study was voluntary. Participants received a $1 USD donation to a non-profit organization of their choice for completing the survey. A total of 41 entrepreneurs responded to the initial survey request. We excluded seven of these cases because they did not adequately describe their business.
To bolster the sample size, we enlisted the Qualtrics panel development team to collect approximately 100 additional survey responses from entrepreneurs. Qualtrics, in addition to providing online survey tools, is a research panel aggregator with the ability to recruit hard-to-reach demographics. Qualtrics utilizes specialized recruitment campaigns to assemble niche survey panels based on pre-specified criteria. To fit in this group, entrepreneurs must own a business that they have started within the last ten years. Respondents in this group were compensated with $25 USD for their participation and were not offered any donation option. A total of 106 completed surveys were returned from this group. We excluded 20 of these cases because they were unable to adequately describe their business. See the Appendix for the complete survey instrument.
Participants and procedures
The participants completed an online questionnaire with thirty-two questions on the details of how they started their business, the success of the business, activities they conducted while starting the business, and demographic variables. The sample was recruited via a snowball sample method as well as through a Qualtrics panel as described above.
The majority of our sample is comprised of Caucasians (81.7%), followed by Black/African Americans (11.7%), then Hispanics (3.3%), then Asians (1.7%). The median age of our sample was 46.5 years old and the sample was 49.2% female. The majority of our dataset is currently married (61.7%) with 55.8% having at least a bachelor's degree. Table 1 shows the means and standard deviations for each of the variables as well as the correlations between them.
Dependent variables
There are various difficulties in obtaining concrete objective measures of success from entrepreneurs. Reasons stem from factors such as small business owners not always running their businesses to maximize financial performance ( Jacobs et al. , 2016 ) or running a business because it allows for a preferred lifestyle ( Jennings and Beaver, 1997 ; Walker and Brown, 2004 ). Because of this, there are a few ways researchers can gain acceptable insight into the success of an entrepreneurial venture. One approach is to use subjective measures when other types of information are unavailable ( Dawes, 1999 ). Thus, following previous research ( Besser, 1999 ; Jacobs et al. , 2016 ) which has noted that entrepreneurial success may not always mean optimal financial measures and instead may be more along the lines of maintaining an acceptable level of income for themselves and their employees ( Beaver, 2002 ) or sustaining a lifestyle more aimed at being part of a creative output than being financially successful ( Chaston, 2008 ), we first analyzed the entrepreneurs' perceived organizational success. A second approach is to ask about objective success measures. We strengthened our study by asking entrepreneurs about objective measures of their firm's success via focusing on their firm's growth, specifically, asking about objective growth indicators in terms of increased number of employees, increased number of customers, or increased revenue as previous research has used these measures to indicate success ( Walker and Brown, 2004 ). Therefore, we analyzed the full model for both the subjective and objective dependent variables.
Given that entrepreneurial motivations can vary widely ( Shane et al. , 2003 ), defining success can vary based on the individual. To address this, studies have surveyed entrepreneurs for their subjective perception of their venture's success ( Fisher et al. , 2014 ; Keith et al. , 2016 ). Walker and Brown (2004 , p. 585) find that “Personal satisfaction, pride and a flexible lifestyle were the most important considerations for these business owners.” They argue that objective, financial measures that are often used in research offer objectivity and accessibility, but may not capture the true value of success for many entrepreneurs. These alternative motivations make success difficult to quantify objectively, leading researchers to utilize more subjective measures. Therefore, in line with prior research on entrepreneurial success perceptions ( Jacobs et al. , 2016 ; Besser, 1999 ), we asked respondents “How strongly do you agree or disagree with the following statement? My business is a success.” Respondents rated their agreement on a five-point Likert scale (1 = Strongly Agree, 5 = Strongly Disagree).
Firm Growth:
To strengthen the findings from our subjective measure of success we also asked respondents about objective measures of firm growth. By asking respondents about obvious measures of growth we can offer a more objective view on the success of the firm. We asked respondents if their firm had grown by any of the following three metrics: number of employees, number of customers, or total revenue (cf. Jacobs et al. , 2016 ). Given the variety of motivations of entrepreneurs, we chose not to limit the type of growth that would reflect success. In some cases, an entrepreneur may seek to increase the impact of the business by providing services to a greater number of customers, while maintaining a lean staff to control pricing. Alternatively, an entrepreneur may be seeking autonomy, and therefore choose not to hire in order to create greater autonomy. However, it is likely that some firm growth – in revenue, employees, or customers – is likely to occur in successful firms. Therefore, we combined these three types of growth as a dichotomous variable, wherein growth in any one or more of these areas would be coded as a “1” for growth and an answer of no growth in all of these areas would be coded as a “0” for no growth.
Independent variables
Business planning.
We defined business planning using four activities. We asked respondents if they (1) wrote a business plan [ Write BPlan ]; (2) gathered secondary data on industry statistics or trends [ Secondary Data ]; (3) shared your business plan with people outside the company for feedback [ BPlan Feedback ]; and (4) shared your business plan with people outside the company for funding [ BPlan Funding ]. These were not loaded as a factor as these do not represent an underlying factor, but rather are individual activities that all represent a variety of activities pertaining to the use of business plans.
We defined lean startup using six activities. We asked respondents if they (1) interviewed potential customers [ Interview ]; (2) created a prototype [ Prototype ]; (3) showed a prototype to potential customers for feedback [ Show Proto ]; (4) conducted an experiment to better understand some portion of your business [ Experiment ]; (5) used customer feedback to alter the direction of your business (“pivoted”) [ Pivot ]; and (6) accepted money for preorders [ Preorders ]. Similar to business planning activities, these were not loaded as a factor, as these activities do not represent an underlying factor, but rather a collection of potential activities.
For each of the IVs, respondents were first asked which of the above activities they engaged in during their venture startup process. The order of the activities was randomized. For each activity that was selected, respondents were asked to rate “how much did each of those activities positively impact the performance of this venture?” Respondents were given a five-point Likert scale (1 = “Not at all” to 5 = “A great deal”) and if the respondent did not do the activity, the response was coded as a 0. To calculate the IVs, each response was weighted by the level of impact. For example, if the respondent rated Experiment as a 5 for a great deal of impact, then it would be coded 5. If it was rated 3, then it would be coded 3. Any activity not completed was not rated (or effectively coded a 0).
We used the ratings to allow for variance in the impact of any activity. In our preliminary interviews, we heard that entrepreneurs may have performed the same activity, such as interviewing customers, but some placed a greater emphasis on this activity whereas others performed it only cursorily. We also performed a robustness check on the data using non-weighted values for the IVs and found similar results (these are available from the corresponding author upon request).
Control variables
We controlled for the following variables: (1) the firm's age in years [Firm Age] ; (2) the entrepreneur's prior startup experience [Ent XP] ; (3) the entrepreneur's age in years [Age] ; (4) the entrepreneur's education level [Education] ; (5) the case sample [case Sample]; and (6) if the firm was a high-tech growth firm [Hi-tech growth firms] . Firm age is likely related to perceptions of success in the minds of entrepreneurs. If an entrepreneur perceives themselves as unsuccessful, they are likely to quit pursuing their venture. Thus, entrepreneurs with older businesses are more likely to have higher perceptions of their own success. Ent XP, Age , and Education have all been investigated in the past for their relationship to entrepreneurial firm performance (e.g. Hechavarría and Welter, 2015 ). We also control for the case sample since our sample was collected in two different processes. Finally, we control for Hi-tech growth firms since some firms in our sample are oriented toward accelerated growth and others may be content with stable returns, which may impact the use and effectiveness of business planning ( Brinckmann et al. , 2010 ).
Regression results for success DV
We tested our hypotheses using hierarchical regression [ 3 ]. In Step 1, we entered Firm Age (in years), the entrepreneur's prior startup experience, the entrepreneur's age, the entrepreneur's education level, the case source, and whether the firm was a hi-tech growth firm as controls ( Van Dyne and LePine, 1998 ). In Step 2, we entered our independent variables that relate to the business plan approach: writing a business plan, gathering secondary data on the industry, sharing the business plan to receive feedback, and sharing the business plan to obtain funding. We also included the variables related to the lean startup approach: interviewing potential customers, creating prototypes, showing prototypes to potential customers for feedback, conducting an experiment to better understand a portion of the business, pivoting based on customer feedback, and accepting money for preorders.
Table 1 reports descriptive statistics and correlations, whereas Table 2 presents the hierarchical regression results for the success dependent variable. As can be seen in Table 2 , consistent with H1a , writing a business plan was related to success ( β  = 0.09, p  = 0.09). However, we do not find support for our other hypotheses: gathering secondary data on the industry, sharing the business plan to receive feedback, and sharing the business plan to obtain funding were all not significantly related to success.
When we looked at the activities that contribute to lean startup methods, we found that interviewing potential customers ( β  = 0.09, p  = 0.08) and accepting money for preorders ( β  = 0.15, p  = 0.03) supported H2a and H2e respectively, suggesting these are correlated with success. Similar to the business plan approach there was not sufficient support for all our hypotheses: creating prototypes, showing prototypes to potential customers for feedback, conducting an experiment to better understand a portion of the business, and pivoting were not supported. The findings with regard to each hypothesis are summarized in Table 3 .
Regression results for growth DV
Similar to the subjective success dependent variable, we tested our hypotheses using logistic regression for our objective growth dependent variable [ 4 ]. A logistic regression was performed for each of our approaches, the business plan and lean startup since our growth DV is dichotomous ( Mason et al. , 2018 ).
Table 1 reports descriptive statistics and correlations, whereas Table 4 presents the logistic regression results for the effects of writing a business plan, gathering secondary data on the industry, sharing the business plan to receive feedback, and sharing the business plan to obtain funding had on our growth dependent variable. The logistic regression model was statistically significant, χ 2 (10) = 39.16, p  < 0.005. The model explained 39.2% (Nagelkerke R 2 ) of the variance in business growth and correctly classified 69.2% of cases. As can be seen in Table 4 , consistent with H1a , writing a business plan was related to success ( β  = 0.30, p  = 0.036). As before we did not find support for our other hypotheses: gathering secondary data on the industry, sharing the business plan to receive feedback, and sharing the business plan to obtain funding.
Next, we looked at the actions that constitute lean startup, interviewing potential customers, creating prototypes, showing prototypes to potential customers for feedback, conducting an experiment to better understand a portion of the business, and pivoting based on customer feedback had on our growth dependent variable. The logistic regression model was statistically significant, χ 2 (12) = 53.82, p  < 0.005. The model explained 51.0% (Nagelkerke R 2 ) of the variance in business growth and correctly classified 85% of cases. Our logistic regression results found that interviewing potential customers ( β  = 0.25, p  = 0.08), accepting money for preorders ( β  = 0.89, p  = 0.04), and pivoting based on customer feedback ( β  = 0.34, p  = 0.03), provided support for H2a , H2e , and H2f respectively, suggesting these are correlated with success in terms of growth. We did not find support for our other hypotheses about lean startup activities. These were, creating prototypes, showing prototypes to potential customers for feedback, conducting an experiment to better understand a portion of the business, and pivoting. The findings with regard to each hypothesis are summarized in Table 5 .
In this paper, we sought to understand the relationship between lean startup activities and success as well as the relationship between business planning activities and success. To answer this question, we began by gathering qualitative data from entrepreneurs to better understand their perspective and language regarding these two approaches. From there, we created a survey and collected responses from 120 entrepreneurs about their activities and their perception of success and the growth of their firms. Controlling for common influencers of success, we found that the act of writing a business plan ( H1a ), interviewing potential customers ( H2a ), and taking preorders ( H2e ) were all correlated with subjective perceptions of success. For the firm growth dependent variable, we found that the act of writing a business plan ( H1a ), taking preorders ( H2e ), and pivoting based on customer feedback ( H2f ) were all correlated with objective measures of firm growth. Interestingly, these results represent a combination of lean startup and business planning activities. What is more, the two activities that are supported by both dependent variables, represent the most well-researched activities. As mentioned, the literature on business planning is well developed ( Honig and Karlsson, 2004 ), and the use of preorders is most directly tied to research on enrolling stakeholders ( Burns et al. , 2016 ) as well as effectuation ( Sarasvathy, 2001 ).
Our results give some understanding to the prior equivocal findings on business planning ( Brinkmann et al. , 2010 ). The qualitative data we gathered suggests that entrepreneurs complete different activities in their business planning process. In the past, there has not been much discussion about separate aspects of business planning or the impact they may have. Our findings suggest that the act of writing a business plan is related to success, but the other business planning activities – gathering secondary data, sharing the business plan for feedback or funding – are not related. This suggests that the planning process itself may mean more than the uses of a business plan. Even if a business plan is not revised or revisited as an entrepreneur pursues their venture ( Karlsson and Honig, 2009 ), the act of writing the plan is still connected with success. Entrepreneurs going through the exercise of planning are likely to gain a better understanding of the entire endeavor of launching a new business. This would give entrepreneurs a better grasp of what the range of possible outcomes would be and likely temper any overly optimistic and unfounded hopes. Therefore, it is likely that simply writing the business plan helps calibrate entrepreneur expectations, which, in turn, helps entrepreneurs achieve success.
Rather than viewing lean startup as a cohesive whole, our qualitative data suggests that entrepreneurs make use of differing combinations of lean startup activities. This discovery informed our survey which offers some of the first direct quantitative evidence of the efficacy of lean startup methods. What we find, however, is that not all activities are linked to success. Perhaps the most straightforward finding is that taking preorders is correlated with both subjective and objective measures of success. If entrepreneurs are able to complete their first sales prior to actually creating their products or services, then success seems much more likely. Venture success, in this case, is agnostic toward the level of innovation in the firm. As such, the critique of lean startup from Felin et al. (2019) as a method that helps orient entrepreneurs to ideas that can be quickly and transparently tested still requires further investigation.
The other relevant activities are those most aligned with customers. Interviewing customers ensures that entrepreneurs design businesses that serve customers rather than building something that no one wants ( Blank and Dorf, 2012 ). However, it is worth noting that interviewing customers must be done with an awareness of the entrepreneur's own cognitive biases ( Chen et al. , 2015 ). Furthermore, pivoting as a result of these discussions with customers also shows a response to customers' desires.
The most interesting aspect of our findings is likely the combination of activities across business planning and lean startup. While lean startup proponents might argue that “no business plan survives its first contact with customers” ( Blank and Dorf, 2012 , p. 53), the act of writing a business plan is correlated with success. It is worth noting that the separation between lean startup and business planning may be a false dichotomy. The underlying activities are not mutually exclusive and do not seem to be detrimental to each other. It is entirely possible, and based on these results advisable, that an entrepreneur would interview customers throughout the process of creating a business plan and use customer feedback to alter both the plan and the business itself. Furthermore, taking customer preorders serves to solidify the relationship between customers and the firm which would only improve that communication.
Limitations
In order to create one of the first quantitative, empirical investigations of business planning and lean startup practices, some tradeoffs needed to be made. We believe that while these limitations may restrict the strength of some of our findings, the direct nature of our approach offers a contribution to the ongoing conversations among scholars and practitioners.
Our sample size is 120. Obviously, a larger sample may lead to more robust and generalizable results. Furthermore, we gathered the sample using two different methods and controlling for the sample method was a significant predictor. We leave it to further research to expand upon our findings and investigate various entrepreneurial samples for differences that may arise.
One of our dependent variables was a subjective measure of success, which may be considered a weakness. We used this measure given the variety of preferred outcomes an entrepreneur may be pursuing – financial objectives, personal objectives, or mission-based objectives. Our other dependent variable was an objective measure of growth across three categories and serves to bolster confidence in the subjective measure.
Another area of concern may be common method variance given that we collected both independent variables and dependent variables from the same instrument. To address this concern, we collected data from individual entrepreneurs that all represented different companies and utilized two different samples so as to minimize the issues that may arise from common method variance ( Chang et al. , 2010 ). Lastly, our independent variables are more objective. For example, writing a business plan is a discrete event as is creating a prototype. For these reasons, we do not believe the common method variance is a major concern for this study.
One other potential weakness is the degree to which entrepreneurs actually utilized the activities of lean startup or business planning. The weighting scheme we employed aims to address this issue by weighting the degree to which entrepreneurs found each activity useful. However, we cannot be sure whether or not an entrepreneur executed the given activity well and this variability goes uncaptured in our study. Quantitative studies like this one will typically suffer from this limitation but case studies may be able to overcome these weaknesses (see Ghezzi et al. , 2015 ).
Finally, our design is cross sectional and does not allow us to make causal inferences. We can only imply the relationship between our independent and dependent variables. Our hope is this is a first step to future research which may be better able to test the causality of the various aspects of business planning and lean startup as they relate to entrepreneurial success.
Implications for research and practice
This manuscript has important implications for research and practice. With respect to research, we have demonstrated that aspects of business planning and lean startup both are associated with success. Furthermore, entrepreneurs seem unlikely to enact either business planning or lean startup wholesale but are likely to pursue individual aspects of these concepts. Future research can investigate how entrepreneurs select between activities as well as how training and education regarding these practices impact the entrepreneurs' choice. The training and education surrounding the entrepreneur represent aspects of the organizing context ( Johannisson, 2011 ), which influence how entrepreneurs construct their firms. Therefore, future research could add further institutional aspects or conduct randomized controlled trials to see the impact of these practices in the organizing context.
In terms of implications for practice, this research highlights the use of a variety of activities when it comes to entrepreneurial success. Some of the activities from both lean startup and business planning are useful for entrepreneurs. This also offers insight for educators as they seek to equip the next generation of entrepreneurs. Educators can offer potential entrepreneurs a wide range of activities without prognosticating one aspect of the false dichotomy between lean startup and business planning.
In this paper, we provide one of the first quantitative empirical studies investigating lean startup methods and business planning. In breaking down these areas, we undermine the false dichotomy between these two startup tools. Our findings demonstrate that truly understanding customers through preorders and interviews can lead to better business plans and better pivots. Ultimately, this results in firms with a greater chance of success. Understanding the variety of activities that entrepreneurs can pursue helps entrepreneurs and educators increase the chances of success for new businesses.
Correlations
Summary regression results for the growth DV
We do not believe that business planning exists as a latent construct necessarily comprised of these activities, but rather each of these activities are potential components of the concept referred to as “business planning” in prior research.
Similar to business planning activities, we believe that lean startup is not a latent construct but rather these activities in some combination is what is meant when practitioners and scholars refer to lean startup. As such we test each of the activities individually rather than as a construct.
Following the extant guidelines on regression assumptions ( Osborne and Waters, 2002 ), we tested our model to ensure the regression assumptions were met. First, to check if our error terms ( Flatt and Jacobs, 2019 ) are normally distributed, the P - P plot suggests normality as the plot is largely linear. Second, to check for a linear relationship between the independent and dependent variable, our residual plot showed a linear relationship. Third, as our variables were not latent, there is no concern for measurement error for this approach. However, we did follow best practices suggested by Flatt and Jacobs (2019) and tested the Durbin–Watson statistic. Our value for this measure is 1.5 and their guidelines are that this statistic should be close to 2. Values between 1.2 and 1.6 represent only a minor violation of the statistical independence of error terms. Finally, to address the assumption of homoscedasticity, inspection of our standardized residuals showed our residuals scattered around the 0 (horizontal line). Therefore, for our dependent variable of success, we can feel comfortable our data meets the assumptions of linear regression.
As this dependent variable was analyzed using logistic regression, we analyzed our data following best practices from Garson (2012) . First, our dependent variable is dichotomous. Second our scatterplot showed no outliers in our data. Third, the correlation table showed no evidence for multicollinearity as no correlations were above 0.9 ( Tabachnick et al. , 2007 ). Hence, we feel our data meets the assumptions for logistic regression.
Appendix Qualtrics Survey
[Business Background]
Started (or am starting it) myself
When you first started pursuing the business, how many people were on the founding team (including yourself)?
High Tech Startup (External/Venture funded)
Steady Growth Business (Internally/Self-funded)
Lifestyle Business
Business Idea
Decision to Start a Business
Occurred Together
Month (1–12)
Year (YYYY)
[Lean Start Up, Business Planning Practices]
Interviewed potential customers
Created a prototype
Showed a prototype to potential customers for feedback
Conducted an experiment to better understand some portion of your business
Wrote a business plan
Accepted money for pre-orders
Used customer feedback to alter the direction of your business ("pivoted")
Gathered secondary data on industry statistics or trends
Shared your business plan with people outside the company for feedback
Shared your business plan with people outside the company for funding
[Demographics]
How old are you? 0.5
Prefer not to answer
Black or African American
American Indian or Alaska Native
Native Hawaiian or Pacific Islander
Living with a partner
Never married
Up to 8th grade
Some High School
High School Diploma
Some College
Associate's Degree
Bachelor's Degree
Some Graduate School
Master's Degree
More than 1
[Success Criteria]
My business is a success
Increased Annual Revenue
Increased Annual Customers
Increased Number of Employees
Thank you for completing the survey!
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A history, from Drucker to Christensen.
A look through HBR’s archives shows that business thinkers use the concept of a “business model” in many different ways, potentially skewing the definition. Many people believe Peter Drucker defined the term in a 1994 article as “assumptions about what a company gets paid for,” but that article never mentions the term business model. Instead, Drucker’s theory of the business was a set of assumptions about what a business will and won’t do, closer to Michael Porter’s definition of strategy. Businesses make assumptions about who their customers and competitors are, as well as about technology and their own strengths and weaknesses. Joan Magretta carries the idea of assumptions into her focus on business modeling, which encompasses the activities associated with both making and selling something. Alex Osterwalder also builds on Drucker’s concept of assumptions in his “business model canvas,” a way of organizing assumptions so that you can compare business models. Introducing a better business model into an existing market is the definition of a disruptive innovation, as written about by Clay Christensen. Rita McGrath offers that your business model is failing when innovations yield smaller and smaller improvements. You can innovate a new model by altering the mix of products and services, postponing decisions, changing the people who make the decisions, or changing incentives in the value chain. Finally, Mark Johnson provides a list of 19 types of business models and the organizations that use them.
In The New, New Thing , Michael Lewis refers to the phrase business model as “a term of art.” And like art itself, it’s one of those things many people feel they can recognize when they see it (especially a particularly clever or terrible one) but can’t quite define.
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Reviewed by Stacy McManus, Adjunct Professor, Minnesota West Community & Technical College on 2/16/23
The book did an excellent job of covering the basics of business. Everything that I cover in my course was covered in this book. read more
Comprehensiveness rating: 5 see less
The book did an excellent job of covering the basics of business. Everything that I cover in my course was covered in this book.
Content Accuracy rating: 4
Book was very accurate, up-to-date and thorough.
Relevance/Longevity rating: 5
The chapters were ordered thoughtfully and progressed in a manner which will help the students to learn the material. Content was up-to-date, and I don't feel that it will be situation where a new edition is required each year.
Clarity rating: 4
The book was clear and easy to understand.
Consistency rating: 4
The e-book is easy to navigate and follows a consistent pattern. The material is pleasing to the eye and is an easy read.
Modularity rating: 5
The chapters are set up well - not too long to lose interest but yet detailed and thorough.
Organization/Structure/Flow rating: 5
The chapters and topics were arranged in a logical manner.
Interface rating: 5
I reviewed the e-book version and did not have any issues with the interface. The book was easy to navigate and the appearance was very professional.
Grammatical Errors rating: 5
No grammatical errors were immediately apparent.
Cultural Relevance rating: 4
I did not notice anything offensive or concerning.
I was excited to find this OER book. It is well done, detailed, and thorough. I appreciated the test banks that were included. I would like to see some recommended activities for each chapter, but overall the book was excellent. I was happy to see an additional chapter on hospitality as well. I look forward to adopting this for my Foundations of Business class.
Reviewed by Marie Looby, adjunct instructor, Massasoit Community College on 6/5/21
Varied subject matters that progress logically and are covered in detail with terms well defined. Offers outside links for further enrichment. read more
Varied subject matters that progress logically and are covered in detail with terms well defined. Offers outside links for further enrichment.
Content Accuracy rating: 5
Found no errors while moving through the text including the quizzes.
The book uses modern day examples that the student can relate to and reference. Although the examples are current the skills are timeless.
Clarity rating: 5
There are embedded links for sources allowing students to access backup while reading online.
Consistency rating: 5
The text shows all the same tools throughout making it easy for students to develop study skills for this book.
The text is organized in chapters with mini quizzes built in as the subject veers in a different direction in each chapter.
The chapters build on the skills and knowledge as they go along eg: group think.
No navigation problems. While clicking on various links there were no difficulties reaching the sources.
Well done and consistent grammar.
Cultural Relevance rating: 5
Illustrations showed diversity
The materials were interesting enough to encourage you to continue reading.
Reviewed by Steve Lesh, Associate Professor, Bowling Green State University on 1/8/21
I must first state that I am a Doctor of Physical Therapy educator who holds a PhD in Business which is not a common combination of degree paths. I was intrigued by the possibility of adding more business theory to my health service administration... read more
I must first state that I am a Doctor of Physical Therapy educator who holds a PhD in Business which is not a common combination of degree paths. I was intrigued by the possibility of adding more business theory to my health service administration courses, but the cost has been historically prohibitive to the students in my experience. We utilize a niche health care admin textbook which misses some of the greater foundational business skills. When this opportunity presented to review materials that I could add to my course without adding cost, I was very pleased. I find Skripak to be comprehensive with the added bonus of my favorite chapter #18 Personal Finances which for Physical Therapy students who typically leave school with great debt to be invaluable!
I found the materials to be easy to read, well organized and did not find errors. I really enjoyed the links to external videos that supported the concepts. I feel the presentation was unbiased.
As this is the second edition with a 2018 publish date it was very current, however, I noticed after I began reading the 2nds edition that a 3rd edition (2020) has been released which updates figures, graphs, and some of the recent law changes. Having the book turn over that quickly makes it even a greater value to me as the instructor and to the student. I appreciate the relevance of being able to submit suggestions or corrections to the author and that they are making a test bank available in support of this material! Doesn't get much better than that!
Well written and not overly technical. The narrative flows well from the beginning to the end of each chapter.
From what I can tell, it is very consistent. I did not observe any changes in tone or terminology, but again, I am reading this through the eyes of someone who has earned a PhD in Business, so it is all very familiar to me.
Modularity rating: 4
When you go to the website, you can easily download each chapter in bits [https://vtechworks.lib.vt.edu/handle/10919/84848]. I first started reviewing the full .pdf of the 2nd edition and found that it didn't have bookmarks for each chapter so the scrolling was a bit annoying. I would add that piece to the full .pdf if possible and it appears they did that in the 3rd ed. However, the module approach online eliminates the need for a full book .pdf download.
Starts with teamwork which is perhaps one of the most important concepts in modern business. So I really appreciate that. The 18 chapters of the 2nd (and 3rd) edition cover all of the major elements of modern business. Certainly, each chapter could be expanded into it's own book. For example, Chapter 14 is Marketing, and there are full marketing textbooks, however, that is not the function of this book. The purpose is to take you through all of the major components of business as opposed to deep dives into each topic.
Again, I loved the interface with online videos. The links appeared to all work. Adds a multimedia approach to the words on the page.
I didn't see any that were obvious during my readings.
There were no elements that were culturally insensitive or offensive that I noted.
I look forward to integrating this open textbook into my Physical Therapy health service admin course as I can now get a glimpse of business fundamentals to supplement the health care niche that my students receive! Thank you for this opportunity. I do have some ideas for writing open textbooks and would be open to doing so. Steven G. Lesh
Reviewed by Babu George, Associate Professor, Fort Hays State University on 10/26/18
This book covers the overall landscape of contemporary businesses pretty well. While nothing significant is 'lacking', I would love to have the authors provide a chapter that quickly takes students through the history of business and another... read more
This book covers the overall landscape of contemporary businesses pretty well. While nothing significant is 'lacking', I would love to have the authors provide a chapter that quickly takes students through the history of business and another chapter that discusses the futuristic dimensions of business.
The contents are accurate. The authors have provided citations to key claims. The references have hyperlinks to more scholarly resources on topics discussed in the book.
Relevance/Longevity rating: 4
The contents are presented in a generalized manner - meaning, the book could stand the test of time for a significant duration. The dynamism of the contemporary businesses could have been captured better, however. The digital transformation of businesses and societies has made the life cycle of knowledge shorter. More stress on e-businesses and digital models would have made the book more relevant.
The authors have used simple English. Overall, the book is very accessible.
Yes, there is a unity of purpose and a sense of unity, throughout the book.
The chapters are stand-alone, for the most part. So, professors need not teach the content sequentially.
Ideas are organized systematically. Every chapter opens with a set of learning objectives and this gives direction to the learners. The students are asked to reflect upon certain key questions, from time to time. Answers to these question are then made available in the content discussed. At the end of each chapter, certain key takeaways are listed. This facilitates a natural form of learning.
No issue noted.
Well written.
No culturally insensitive use of language or images noted. However, in the forthcoming iterations, the authors are requested to bring in more dimensions of global businesses. Examples of business practices in other countries and cultures would add value.
One chapter (Chapter 15: Hospitality and Tourism) does not make a lot of sense. One might wonder why the authors devoted a full chapter for one industry! Why not similar chapters for other industries? It almost sounds like one of the authors had a chapter written for some other purpose, which needed to be inserted in this book. There are several other examples and case studies related to tourism in this book, too. Thinking of it positively, this book thus has an added advantages for students majoring in Hospitality and Tourism.
Reviewed by Mindy Bean, Faculty, Linn-Benton Community College on 6/19/18
The OER does well on covering topics in an introductory level business course. It adds a section that is not in typical business fundamental material of hospitality which compliments our new program that we started at our college. read more
The OER does well on covering topics in an introductory level business course. It adds a section that is not in typical business fundamental material of hospitality which compliments our new program that we started at our college.
The book is consistent with most material that is available.
The examples in the book are commonly used in most topics of basic business fundamentals. It should hold relevancy for 4-5 more years.
The book is clear in the writing that can be easily read. Business terms are well represented and explained thoroughly. The material is written well for a student's first time learning business and how to apply it to what is happening around them.
The book is consistent from chapter to chapter. The sources of material are well represented. Visuals compliment the written material.
The chapters are seamless with transition from topic to topic. It could easily be broken up into sections of reading during certain points in the course. This text seems to be set up well for student team work to learn on each important topic of business basics.
Chapters are organized in a good way to learn all material and have it related to each former chapter. Personally I will be teaching the chapters in a different order to complement a business plan being created by students.
Interface rating: 3
The book could use a few more visuals for students to relate to the material. Some of the visuals could use improvement, but as for the written material, it is clear and written well for beginners understanding business.
I did not find any grammatical errors.
Globalization section addresses cultural differences in a way that is not culturally insensitive or offensive in any way. It used examples of variety of countries and global management practices.
Reviewed by Jeff Bauer, Professor of Management & Dean, University of Cincinnati - Clermont on 3/27/18
The text is quite comprehensive covering: ECON, Ethics, Global Business, Forms of Ownership, Entre, MGMT, OB/OD, OM, Motivation, H/R, Unions, MKTG, Pricing, Hospitality MGMT, ACCT/FIN, and Personal FIN. Only areas "missing" = Information Systems... read more
Comprehensiveness rating: 4 see less
The text is quite comprehensive covering: ECON, Ethics, Global Business, Forms of Ownership, Entre, MGMT, OB/OD, OM, Motivation, H/R, Unions, MKTG, Pricing, Hospitality MGMT, ACCT/FIN, and Personal FIN. Only areas "missing" = Information Systems and Data Analytics/Analysis.
Well researched and the sources are thoroughly documented.
With a 2016 publication date, it is up-to-date and should have a shelf life of several years. The biggest challenge will be updating the stories/vignettes as new information becomes available on the firms mentioned and technology inevitably impacts the content.
The material is easily accessible to the Introduction to Business student. Well written and the material flows well. Terms/jargon are thoroughly explained in the chapter and at the end of each chapter.
Consistency format for each of the chapters and interspersed well with photos, charts, and real-world stories.
The layout presents the material well and is easy to read. Chapter lengths and the length of the entire text fit well with the organization of a class over a semester.
I might organize the material a bit differently as the Global and Ethics items are early in the text and I might bump them to later in the term after additional terminology is learned and can be applied to that material. That said, overall the text is laid out logically and "like" content is connected in successive chapters, e.g. MGMT then OB/OD, etc.
Worked fine for me reading it on-screen.
I did not edit the text, but nothing glaring related to grammar jumped out at me.
On the contrary, I think the text tackles diversity head on and provides a good review of the 21st Century workplace and marketplace.
I am VERY likely to adopt this text for the next Intro to Business class that I teach.
Reviewed by Thomas Goodwin, Part-time Instructor, Miami University on 6/20/17
This text does a good job of introducing key functions of an organization (Marketing, HR, Accounting/Finance) as well as core principles such as ethics, legal issues, and economics. The material is appropriate for an introductory course to serve... read more
This text does a good job of introducing key functions of an organization (Marketing, HR, Accounting/Finance) as well as core principles such as ethics, legal issues, and economics. The material is appropriate for an introductory course to serve as the foundation for general business or to move on to a concentration in any of these business disciplines. There are two chapters that do not quite seem to fit in with the rest of the text: chapter 12 discusses Union/Management Issues, which makes sense in the flow of the book that it follows chapter 11 on HR, but for an introductory course the chapter 12 topic gets into a lot of HR detail not generally covered in an introductory course. Chapter 15 focuses on the hospitality and tourism industry. This is a very specific chapter embedded within the book about an industry while the rest of the book is mostly general information that could be applied to any number or types of organizations. Still, out of 17 chapters there are 15 solid chapters that provide great content and overview of the subject matter.
The book is written in an easy to read format with no noticeable grammatical errors or formatting issues. It is easy to find topics within chapters based on the layout, fonts, etc. The information itself is rooted in fundamental concepts of each chapter's topic or subject matter within the business discipline and there are no overt attempts to lead the reader in a particular manner to form bias or opinions, other than to establish critical thinking of topics.
While there are some examples that may seem somewhat dated, they are explained in a manner that is easy to understand and they are relevant (or "fit") within the context of the chapters and course concepts being discussed. The book is quite lengthy but given the 17 chapters that is to be expected. The author could probably eliminate two chapters on ancillary material to make it a shorter text but the chapters are not unnecessarily bloated for the sake of adding more vocabulary or unnecessary graphics.
The book uses easy to understand language, explains course concepts and terminology, and reinforces abstract ideas with examples. Overall it does a good job of relaying topics that are being introduced to students for the first time.
The text remains consistent in present tense tone of voice, chapter structure is organized consistently throughout the text, and the use of masculine vs. feminine language is muted so that it presents information to readers in a gender-neutral manner.
One could easily pick up this course text and only read select chapters that were of interest. Gaining an understanding of the legal topics (Chapter 5 Forms of Business Ownership) was not necessary to learning about subsequent chapters such as Marketing, HR, economics, etc. An instructor could pull needed material from this course text to supplement other teaching materials as well as to expand on the introductory materials contained herein to build out a more robust, in-depth course on any of the topics contained within this textbook.
Organization/Structure/Flow rating: 4
There is a very logical structure with the early chapters discussing types of business formation, teamwork, and ethics before moving to more operational activities such as financing, marketing, management and so forth. A few chapters could be reorganized. The ethics chapter could be moved to coincide with the legal (chapters 3 & 5) and there are two chapters that do not seem to fit with the introductory material (Chapter 12 on Unions and Chapter 15 on Hospitality & Tourism) but otherwise the book had a good flow of advancing through the broad goal of introducing multiple aspects of business.
Interface rating: 4
The book could use more graphs, pictures, diagrams, etc. to emphasize course concepts; however, the author made the textbook very easy to read (especially online) so the lack of numerous photos or graphics may conversely make it easier to download and read as plain text.
Grammatical Errors rating: 4
There are no noticeable grammatical, spelling, or punctuation errors. There are a few figures that are either not labeled or are not appropriately referencing the course text where they are presented, leaving "floating images" in some places that have no meaning to the topic discussed. Figure 7.3 on page 167 is an example. There is a photo of someone's arm by a laptop and notepad next to sections discussing operational plans and planning for contingencies or crises.
Gender neutral language is used throughout the course text and no offensive references are made or examples presented. The textbook examples cover a wide array of businesses, industries, and geographical reference points.
This course is an excellent resource for a first-year business student that is seeking a broad overview of several business disciplines and to lead into more in-depth study of the course topics throughout an undergraduate curriculum.
Reviewed by Ann Strunk, Adjunct Instructor, Klamath Community College on 6/20/17
The text covers all the typical topics for introductory business course. The Chapter 15: Hospitality and Tourism is relevant to the increasing industry segment. The last chapter on Personal Finances does come after Chapter 16 Accounting but seems... read more
The text covers all the typical topics for introductory business course. The Chapter 15: Hospitality and Tourism is relevant to the increasing industry segment. The last chapter on Personal Finances does come after Chapter 16 Accounting but seems out of place with no connection to the rest of the text.
There does not seem to be any errors or biases.
The textbook was recently written making issues and news items current. Social media marketing is thorough discussed. The Marketing chapter introduces the SAVE marketing model which is taking the place of the four Ps of the marketing mix. Historic ethics cases such as WorldCom and Bernie Madoff are presented.
Pages are of a simple layout with easy readability. All terms are defined and this would also be an appropriate text to use with high school dual credit courses.
Graphics are appealing and provide a distinct look for the various sections of the text. All chapters start with learning objectives and end with take-aways. The individual chapters are of various lengths. Chapter 12: Labor Unions covers just the one topic. Other chapters are much longer with up to seven sections.
There many chapters that could be assigned or presented in a different sequence. It is easy to find and refer to tables and divisions of the chapters.
I find the placement of teamwork as the preface could be very be very beneficial in setting up for class activities and useful for students as they become active in college clubs and organizations.
Effective graphics make the chapters and sections clear. There are very few photos and those are clear and useful.
I found no grammatical errors.
Cultural differences, of course, are addressed in Chapter 4: Globalization of Business. Although there are few photos only one features a person of color.
While the chapter concepts are summarized with "Key Take-Aways", there is no end of chapter "check for understanding" such as review questions, discussions, or activities. Adoption of this textbook would require significant development of assessment tools. The references section at the end of the book is organized by chapter and provides a valuable resource of website hyperlinks.
Reviewed by Ehsan Salek, Professor of Business, Virginia Wesleyan College on 2/8/17
The text has an extensive coverage and actually has several chapters one doesn't normally find in an introductory textbook on business. If this was a traditional textbook, I would not adopt it since there are superfluous chapters and sections that... read more
The text has an extensive coverage and actually has several chapters one doesn't normally find in an introductory textbook on business. If this was a traditional textbook, I would not adopt it since there are superfluous chapters and sections that I would not want in the book but since I can custom-make an electronic copy, I would cut the unnecessary section.
The content is standard and can be found in many similar textbooks. I did not find any errors or biased opinion. All assertions are backed by reputable sources.
In such a book, the only areas that need regular updating are the examples, vocabulary, and technology. 1. Examples must be current, real, and interesting for the students in order to drive home the issues. Most recent news from companies like Apple, Amazon, or Starbucks attract the attention of students. 2. Vocabulary. "Human Resources" instead of "Personnel" or "Tossed salad" instead of "Melting Pot," etc. 3. Technology. Other than specific case studies which might have a historical significance, all references to hardware, software, and telecom should show the most current examples.
It flows well if a freshman or any student new to the business major (otherwise why one would read such a book) can get past the boring look and "feel" of the book. the book looks like a long term paper! Proper use of deeper indentations and special boxes can give the book a more interesting and magazine-like feel, although I understand that part of the bland look is due to cost restrictions.
I did not find any inconsistencies.
The book, by it's electronic nature, is naturally flexible but only to the extent of being able to cut or move materials but I am not sure if an adopter can add his/her own chapters/sections.
Organization/Structure/Flow rating: 2
This is where I will offer the bulk of my feedback. A. Why does TEAMWORK has its own special section before the chapters start? It should be moved to chapter 7, 8, or 10. B. Chapter 12 (Union-Management Issues) is not necessary in such a basic business text. The topic can be subsumed under chapter 3 or 11. C. Another superfluous chapter is #15 (Hospitality and Tourism). It looks like one of the contributors to this text has a specialty in this area. For instance, do students also need to read a chapter about Real Estate or another one about the Airline Industry? D. As much as Personal Finance (chap. 17) is a very useful topic, especially for younger generation of students, allocating a separate chapter to it seems unnecessary to me. How about moving an itemized summary of it to an appendix at the end. E. In place of the deleted chapters, add or restructure as follows, so as to have more chapters about marketing which has the effect of making the text a lot more interesting for the commercial and consumer-driven society we all live in. Chapter 13, Marketing (Introduction to the topic plus discussion of the Product aspects) Chapter 14, Marketing (Price & Place) or (Price and Distribution) Chapter 15, Marketing (Promotion & Advertising)
The only interface issue I found is mentioned in #7.
Grammar is good.
I did not find any of words or phrases that may come across as culturally insensitive or politically incorrect.
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Ancillary Material
About the book.
Fundamentals of Business , 4th Edition is an open education resource intended to serve as a no-cost, faculty-customizable primary text for one-semester undergraduate introductory business courses. It covers the following topics in business: Teamwork; economics; ethics; entrepreneurship; business ownership, management, and leadership; organizational structures and operations management; human resources and motivating employees; managing in labor union contexts; marketing and pricing strategy; hospitality and tourism, accounting and finance, personal finances, and technology in business. The textbook was designed for use in Virginia Tech’s Pamplin College of Business introductory level business course, MGT1104 Foundations of Business and is shared under a Creative Commons Attribution Non-Commercial ShareAlike 4.0 license.
If you are an instructor reviewing, adopting, or adapting this textbook, please help us understand your use by filling out this form http://bit.ly/business-interest .
A testbank is now available by request for this book: http://hdl.handle.net/10919/93404 . The testbank covers chapters 1-18 and (currently) aligns to previous editions of the textbook. It is  available to any instructor who has adopted Fundamentals of Business in their course.
About the Contributors
Stephen J. Skripak  is (retired) Professor of Practice in Management at Pamplin College of Business, Virginia Tech (2005  – 2021) and former Associate Dean for Graduate Programs (2006-2014). He is a senior executive with 25 years of business leadership experience, including positions as General Manager and Chief Financial Officer with divisions of Fortune 500 companies. His background includes financial services, consumer packaged goods, apparel, and industrial companies, with emphasis in turnaround situations. He was the lead contributor and subject matter expert for the 2016 and 2018 editions of  Fundamentals of Business , and reviewed the 2020 and 2023 versions of the book.
Ron Poff is Assistant Professor of Management Practice in the Management Department at Pamplin College of Business, Virginia Tech, where he teaches management courses. He began his career as an enlisted member of the US Navy Reserves before entering his primary career in supply chain operations then sales and marketing, where he served in executive roles with large corporations for over 25 years. As an entrepreneur, he then founded his own marketing agency. His education includes a B.S. in Business Management, M.S. Marketing, and a Graduate Certificate in eMarketing. He is the project lead, chief contributor, and coordinator of contributors for the third (2020) and fourth editions (2023) of Fundamentals of Business.
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A Hedge Fund Business Plan: Investment Theory, Operations, and Capital Raising for Broadgates Capital Management By A4IP

Related Papers
Dr. Asif Kamran
This study analyzes and explores the Scope of Hedge Fund in Pakistan. Due to time constraint the research is limited to certain core point. Main focus is to find out the reason why Hedge fund is not started in Pakistan till yet, what are the major problems hedge fund has to encounter. What style and strategies will be successful in Pakistan and what are the main challenges that the hedge fund has to face in Pakistan. Due to shortage of primary data availability in references of Pakistan, the study is design in an exploratory form to get the maximum insight over the topic with in limited time period. Data is gathered through questionnaire and interviews both are structured. The respondents of the study are the top head of Investment banks as the investment bank play a big role in bringing Hedge funds in Pakistan economy and financial market. One interview is conducted with Dr. Ishrat Husain to find out the view of regulatory bodies over the issue. Through this research it is found that there are very few investment strategies/option available for hedge fund which can limit the huge investment style menu to very few options. And if we start hedge fund on this stage it would not as successful idea as it globally. Keywords Commodity trading advisor (CAT) · Collateralized mortgage obligations (COMs) · Real estate mortgage investment conduits (REMICs) · Stripped mortgage-backed securities (SMBSs) · Fund of funds (FOF) · Hedge fund returns (HRF)

U. Pa. J. Bus. & Emp. L.
Sofia Johan
iaeme iaeme
Review of Banking and Financial Law
Journal of Insurance and Financial Management
[JIFM] Journal of Insurance and Financial Management
Following the crisis of Long Term Capital Management (LTCM), concerns about the hedge funds have increased tremendously. Since the LTCM crisis; hedge fund industry has grown impressively, attracted many investors due to the high rate of returns and has begun to act as financial market leaders which also in return increased the concerns. The problems that hedge funds are able to cause, were seen during this crisis and proved that the benefits of hedge funds can easily be reversed and cause a financial disaster. This ability of hedge funds took the attention of regulatory authorities. This paper discusses the costs and benefits of the hedge funds, shows how hard it can be to impose further regulations on the problematic areas and tries to come up with some possible solutions for these problems that threaten the systemic stability.
Journal of Finance and Economics
This study investigated the portfolio characteristics and investment performance of alternative mutual funds from April 1993 to March 2013, focusing on Bear Market mutual funds, Market Neutral mutual funds, and a sampling of traditional stock mutual funds. The results indicate that alternative mutual funds are, on average, younger and smaller in size than the average traditional fund. Alternative funds, however, have significantly larger expense ratios, larger portfolio turnover, and fewer portfolio holdings. Bear Market fund returns generally move in the opposite direction of the stock market, whereas Market Neutral funds and the average traditional fund returns rise and fall with the stock market. The two categories of alternative funds underperformed the traditional funds, with substantially greater variability of returns and larger tracking errors. Furthermore, Bear Market funds had a negative beta and were more volatile than the stock market, whereas Market Neutral funds had a near-zero beta, making them less volatile than the stock market. The performance of the average traditional fund was not significantly different from zero, and its beta did not differ significantly from unity.
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Home Care Business Plan PDF Example

	February 19, 2024
	Business Plan


Creating a comprehensive business plan is crucial for launching and running a successful home care business. This plan serves as your roadmap, detailing your vision, operational strategies, and financial plan. It helps establish your home care business’s identity, navigate the competitive market, and secure funding for growth.
This article not only breaks down the critical components of a home care business business plan, but also provides an example of a business plan to help you craft your own.
Whether you’re an experienced entrepreneur or new to the healthcare industry, this guide, complete with a business plan example, lays the groundwork for turning your home care business concept into reality. Let’s dive in!
Our Home Care business plan is designed to address all vital elements necessary for a detailed and effective operational strategy. This plan encompasses the scope of our home care services, marketing approaches, the environment in which we operate, an analysis of our competitors, the structure of our management team, and financial projections. 
	Executive Summary: Offers a succinct overview of the Home Care business’s unique proposition, highlighting personalized and professional in-home care services tailored for seniors, market analysis showcasing the sector’s growth and demand, management’s expertise in senior care, and a financial strategy that outlines investment opportunities and revenue expectations.
	Services & Area Coverage: Describes the array of in-home care services, including personal care, medication management, specialized care for dementia, and emergency response, all delivered within a specified service radius to meet the unique needs of each senior.
	Pricing: Details the pricing strategy, designed to be transparent and competitive, offering flexible options to cater to various financial situations of clients, including hourly and flat-rate packages tailored to different care needs.
	Key Stats: Presents data underscoring the market size, growth trends, and demographics that illustrate the potential and necessity of home care services.
	Key Trends: Highlights significant trends such as the increasing preference for aging in place, the integration of technology in care, and a shift towards personalized care.
	Key Competitors: Analyzes the main competitors within the service area, their offerings, and how the business’s unique approach and technology set it apart.
	SWOT Analysis: Conducts a comprehensive analysis of Strengths, Weaknesses, Opportunities, and Threats to strategically position the business.
	Marketing Plan: Outlines marketing strategies aimed at building brand awareness, attracting new clients, and retaining them through superior service, patient satisfaction programs, and targeted marketing efforts.
	Timeline: Sets forth key milestones and objectives from the business setup to its launch and key growth phases.
	Management: Highlights the experienced team leading the business, from caregiving professionals to administrative management, emphasizing their roles in ensuring high-quality care and operational success.

Financial Plan: Projects the financial outlook for the business over the next five years, detailing revenue models from various services, cost management strategies, profit margins, and expected return on investment, ensuring a clear route to financial sustainability and growth.

Home Care Business Plan
Download an expert-built 30+ slides Powerpoint business plan template
Executive Summary
The Executive Summary introduces your home care business plan, offering a concise overview of your agency and its services. It should detail your market positioning, the range of home care services you offer, including personal care, nursing care, and companion services, its service area, and an outline of day-to-day operations. 
This section should also explore how your home care agency will integrate into the local community, including the number of direct competitors within the area, identifying who they are, along with your agency’s unique selling points that differentiate it from these competitors. 
Furthermore, you should include information about the management and co-founding team, detailing their roles and contributions to the agency’s success. Additionally, a summary of your financial projections, including revenue and profits over the next five years, should be presented here to provide a clear picture of your agency’s financial plan.
Make sure to cover here _ Business Overview _ Market Overview _ Management Team _ Financial Plan

Dive deeper into Executive Summary
Business Overview
For a Home Care Business, the Business Overview section can be effectively divided into 2 main slides:
Services & Area Coverage
Briefly describe the range of home care services your agency offers, emphasizing the personalized and compassionate care provided to clients in the comfort of their own homes. This can include personal care services like bathing and dressing, skilled nursing care, physical therapy, and companion services such as meal preparation and light housekeeping.
Then, mention the geographic area your agency covers, highlighting the convenience and accessibility of your services to clients within this area. Explain why your service area is strategically chosen to meet the needs of your target clientele, considering factors like population demographics and the presence of community resources.
Pricing & Payment Options
Detail your pricing structure for the various home care services offered, ensuring it reflects the quality of care provided and is competitive within the market you’re targeting. Your pricing strategy should be transparent, making it easy for clients and their families to understand the cost of care.
Also,highlight any flexible payment options, insurance partnerships, or programs that can help offset the cost for clients, such as Medicaid, Medicare, or private insurance coverage. Emphasize any packages or special programs that provide added value to your clients, such as customized care plans or discounted rates for long-term services, encouraging long-term relationships and client loyalty.
Make sure to cover here _ Services & Area Coverage _ Pricing & Payment Options

Market Overview
Industry size & growth.
In the Market Overview of your home care business plan, start by examining the size of the home care industry and its growth potential.
This analysis is crucial for understanding the market’s scope and identifying expansion opportunities, particularly in the context of an aging population and increasing preference for aging in place.
Key market trends
Proceed to discuss recent market trends, such as the growing consumer interest in personalized home care services, the use of technology to improve service delivery, and the emphasis on holistic care that encompasses physical, emotional, and social well-being.
For example, highlight the demand for services tailored to specific health conditions or preferences, alongside the rising popularity of integrated care models that coordinate across different healthcare providers.
Key competitors
Then, consider the competitive landscape, which includes a range of providers from large national chains to local independent agencies, as well as emerging tech-based care solutions.
Emphasize what makes your agency distinctive, whether it’s through exceptional caregiver training, a comprehensive range of services, or specialization in certain types of care (e.g., dementia care, post-operative care).
Make sure to cover here _ Industry size & growth _ Key market trends _ Key competitors

Dive deeper into Key competitors
First, conduct a SWOT analysis for the home care business, highlighting Strengths (such as compassionate and well-trained caregivers, a comprehensive range of services), Weaknesses (including potential regulatory challenges or staffing issues), Opportunities (for example, an aging population and increasing preference for home-based care), and Threats (such as changes in healthcare policies that may affect funding or reimbursement).
Marketing Plan
Next, develop a marketing strategy that outlines how to attract and retain clients through targeted outreach, informative and empathetic communication, engaging online presence, and community partnerships. Emphasize the importance of building trust with clients and their families, showcasing testimonials, and highlighting the qualifications and dedication of your caregiving team.
Finally, create a detailed timeline that outlines critical milestones for the home care agency’s launch, client acquisition efforts, service expansion, and strategic objectives, ensuring the business advances with clear direction and purpose. Include key benchmarks for assessing the quality of care, client satisfaction, and operational efficiency to continually improve and grow your agency.
Make sure to cover here _ SWOT _ Marketing Plan _ Timeline

Dive deeper into SWOT
Dive deeper into Marketing Plan
The Management section focuses on the home care business’s management and their direct roles in daily operations and strategic direction. This part is crucial for understanding who is responsible for making key decisions and driving the home care business towards its financial and operational goals.
For your home care business plan, list the core team members, their specific responsibilities, and how their expertise supports the business.

Financial Plan
The Financial Plan section is a comprehensive analysis of your financial projections for revenue, expenses, and profitability. It lays out your home care business’s approach to securing funding, managing cash flow, and achieving breakeven.
This section typically includes detailed forecasts for the first 5 years of operation, highlighting expected revenue, operating costs and capital expenditures.
For your home care business plan, provide a snapshot of your financial statement (profit and loss, balance sheet, cash flow statement), as well as your key assumptions (e.g. number of customers and prices, expenses, etc.).
Make sure to cover here _ Profit and Loss _ Cash Flow Statement _ Balance Sheet _ Use of Funds

Privacy Overview
How to Write a Food and Beverage Business Plan + Sample Business Plan PDF

Elon Glucklich
7 min. read
Updated February 17, 2024
Free Download: Sample Food and Beverage Business Plan Templates
The food and beverage sector is booming. Restaurant openings rose 10% in 2023 compared to 2022 — even higher than in pre-pandemic years.
From fine dining to food trucks, farmers to brewers, and wholesalers to coffee makers, there are opportunities across the food and beverage industry. 
But starting a business without covering the basics — your operations plan, marketing tactics, financial strategy, and more — carries huge risks. 
That’s why we recommend you write a business plan.
	Why write a food and beverage business plan?

Writing a business plan is an easy first step that you can start for free. Plus, businesses that take time to plan are significantly more successful than those that don’t.
Many food and beverage establishments fail because of one of the following:
	Poor inventory management
	Underestimated expenses
	High employee turnover
	Misjudged the size of their market

Writing a business plan can help you:
	Develop processes for managing inventory and logistics
	Understand your cash flows and create a realistic expense budget
	Budget for competitive employee pay that increases worker retention
	Analyze your competition and determine how big your market is  

If you’re looking for funding from investors for your business, you’ll definitely need a business plan.
Brought to you by

Create a professional business plan
Using ai and step-by-step instructions.
Secure funding
Validate ideas
Build a strategy
	How to write a food and beverage business plan

Many business plans follow a standard format and you can use it as a starting point when writing your own plan. Here’s what that includes:
Executive summary
	Company summary and funding needs
	Products and services
	Marketing plan
	Management team

Financial plan
For food and beverage companies, you must give extra attention to your market analysis, operations plan, and financial forecasts.
If you’re ready to start, download a free business plan template and fill it out as you read this article.

Every business plan should include an executive summary . It’s a brief outline summarizing the plan, no more than one or two pages.
We recommend that you write the executive summary last after fleshing out the details of your plan. 
Just summarize the vision for your business, describe your offerings and target market , and touch on your management team and financials. Don’t go into tons of detail — just provide a high-level sense of what you want your business to accomplish.
Opportunity: problem and solution
This section of your food and beverage business plan describes the opportunity you hope to capture.
Maybe you’re a farmer looking to diversify your revenue streams by distributing to grocery stores. Or a bar owner with high-end liquor that competitors in the market aren’t serving. 
Whatever your business is, describe the gap in the market and how you aim to fill it.
If you’re operating a more common type of business, like a restaurant , you can probably keep this section short. But it’s useful to document what makes your business unique and it will help focus your sales and marketing efforts later on.
Market analysis
In a field as crowded with competitors as the food and beverage space, a detailed market analysis is essential. 
Your focus should be on identifying the specific customer segments you aim to serve. 
Maybe you’re a butcher with connections to fresh livestock. Will you be more successful selling directly to consumers, or should you focus on selling to grocery stores and markets in your area?
Or, you’re opening  a diner. Should your menu focus on healthy meals or easy-to-make child-friendly options?
These are the types of questions that market research helps you answer. This section should detail the defining characteristics of your target market, including the demographics and preferences of your ideal customer and the size of the market you’re targeting. Market research questions specific to a food and beverage business could include:
	Business location and characteristics
	Area income
	Local food and beverage preferences
	Existing food and beverage options 

Elaborate on how your food and beverage offerings align with that target market ’s needs. Remember, you can’t please everyone, so focus on a specific group of people or type of person and build out from there.
Marketing and sales
For food and beverage businesses promotions are how you stand out and seize a share of your market.
The marketing and advertising chapter of your business plan is where you’ll detail your strategies for capturing the attention — and loyalty — of the customers you identified as your target market in the previous section.
With so many options for consumers in the food and beverage space, you’ll likely have to rely on multiple marketing channels , including::
	Advertising on websites, television, and in relevant publications.
	Content marketing — developing an engaging website and writing blog content that’s search engine optimized to drive traffic to your site.
	Engaging with your customers on social media.
	Offering discounts and customer loyalty programs.
	Appearing at food and beverage industry trade shows and community events.

It doesn’t matter how delicious your recipes are, how fresh your crops are, or how innovative your cocktails are — if you don’t operate efficiently, your business probably won’t last long.
The operations strategy may be the most detailed section of your business plan, especially if you’re writing it for a bank loan or investment. This section describes how you will run your business day to day.
When writing the operations section, describe the following:
Physical space
Whether it’s a restaurant, a farm, or a food transportation business, describe the space you’re operating in, and all of the physical assets and equipment you’ll need to be successful. 
If it’s a sit-down restaurant, consider including a floorplan mockup in your appendix.
Supply chain 
List the suppliers and partners that get your product to customers. Think about the businesses you purchase ingredients from, the warehouses that goods are stored in, and the trucking companies that deliver your products to grocery stores. 
These are your supply chain partners. It’s crucial that you maintain good relationships with them.
Production processes
How long it takes to make your product, and what materials and equipment are required. Documenting how you produce your goods or services demonstrates that you understand the costs of making them. 
You may also uncover ways to produce them more quickly, or at a lesser cost.
Detail how you’ll handle matters of efficiency like order fulfillment, storage, shipping, and returns, as well as customer satisfaction. If you provide delivery services, document how you will handle the process of getting your product to customers’ homes or businesses.
List your staffing needs, training, and experience requirements for key staff. Also, document the management structure of your business. 
This helps ensure that important tasks you don’t have time to monitor are being done and that workers are being supervised.
Describe investments in payment processing systems, inventory management software, and other tools that support sales or operations in your business. Cataloging your technology systems will help you determine where it might make sense to invest in upgrades for efficiency.
Take some time to write a financial plan . Create detailed financial projections, including sales , expenses , and profitability .
If that sounds intimidating, take a deep breath, and remember that financial forecasts are really just best guesses. If you’re running an existing business, you can start with your previous year’s numbers. If you’re starting, make an educated guess about where you hope to be financially a year from now.
Investors will want to see a: 
	Sales forecast
	Income statement (also called a profit and loss statement )
	Cash flow statement
	Balance sheet 

If you use a tool like LivePlan , you’ll be able to build out your financial forecasts relatively quickly, even if you don’t have experience with business numbers.
Even if you aren’t seeking investment, the financial plan is crucial for understanding the viability of your business. It allows you to adjust your business model based on projected performance, and make informed decisions about where to spend your money.
	Food and beverage business plan templates and examples

If you want to see how other food and beverage businesses have created their plans, check out our free library of food and beverage business plans . 
You can download all of them in Word format and jump-start your own business plan.
See why 1.2 million entrepreneurs have written their business plans with LivePlan

Elon is a marketing specialist at Palo Alto Software, working with consultants, accountants, business instructors and others who use LivePlan at scale. He has a bachelor's degree in journalism and an MBA from the University of Oregon.
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The quickest way to turn a business idea into a business plan
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Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.
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An Explosive Hearing in Trump’s Georgia Election Case
Fani t. willis, the district attorney, defended her personal conduct as defense lawyers sought to disqualify her from the prosecution..
This transcript was created using speech recognition software. While it has been reviewed by human transcribers, it may contain errors. Please review the episode audio before quoting from this transcript and email [email protected] with any questions.
From The New York Times, I’m Michael Barbaro. This is The Daily.
[MUSIC PLAYING]
Our relationship wasn’t a secret. It was just private. So —
It is an inaccurate way to state the question —
Then I will certainly restate it so it is very accurate.
OK. And please do not yell at me.
An explosive and emotional court hearing on Thursday in Georgia has revealed that what once seemed like a long shot legal challenge to an election interference case against Donald Trump and his allies is now a serious threat that could derail the entire case.
No, no, no, no. This is the truth.
And it is a lie. It is a lie.
My colleague, Richard Fausset, walks us through the dramatic opening day of testimony.
It’s Friday, February 16th.
Richard, this was one of the most remarkable court hearings I’ve ever seen, and I watch a lot of court hearings. It was cinematic. It was suspenseful. It was angry. I mean, at one point, the judge stopped the proceedings to ask everyone to calm down. And it was extraordinarily high stakes.
That’s exactly my reaction. There was no idea when the hearing started this morning where it was going to go. Lawyers were making on the fly arguments based on stuff they had just learned. A star witness we thought was going to change the whole shape of the day and perhaps the week didn’t end up being the star witness. It ended up being somebody else. And then, of course, we just had this absolute white hot torrent of emotion from Fani Willis, the prosecutor, in this election interference case.
And the whole time, you’re thinking about the stakes, which is that this tremendous criminal case that has a former president in its crosshairs is potentially under threat.
Right. Well, I think we have to rewind the clock just a few weeks to establish why this hearing happens and why it is so important and why the drama of this day matters. And this all starts — and I want you to explain this — with a defendant that most of us had never really heard of in this Georgia racketeering case against Donald Trump and his alleged co-conspirators who are accused of allegedly criminally attempting to overturn the Georgia election. So tell us the story of that defendant and how he brings us to this hearing.
Sure. So this criminal prosecution started out with an indictment of 19 people, including some serious high profile names. Among them, of course, Donald Trump. Rudy Giuliani, who was a defendant. Mark Meadows, who served as Donald Trump’s White House Chief of Staff toward the end of his term. But there are also this array of much more obscure and fascinating individuals.
And one of them was a guy named Michael Roman, and that’s the guy you’re talking about. He was a top official in Trump’s 2020 campaign. He was Trump’s director of election day operations. And he was involved with a number of other lawyers and aides to Donald Trump in creating this idea that there should be these fake electors who could somehow serve as the actual electors to turn the election that Mr. Trump lost in his favor and keep him in the White House.
But he definitely was not like —
A brand name defendant.
Exactly, thank you. So this case was really rocking along, and it really was a case where the prosecution seemed to have the upper hand. It was pretty airtight in a lot of ways. And four of the 19 original defendants had taken guilty pleas. But what happened is there was one of these many pretrial deadlines on January 8th. And out of the blue, Michael Roman’s lawyer drops this absolute bomb of emotion in which she makes some allegations that sent the entire case down this course of a telenovela melodrama that nobody saw coming.
Well just describe this telenovela-esque motion that Michael Roman and his lawyer filed.
So the motion that sent everything into this very different direction alleged that Fani Willis, the district attorney who is heading up the prosecution, was engaged in an affair with the man she hired to manage the case, a man named Nathan Wade. And that he had been paid hundreds of thousands of dollars by the DA’s office. And he’d used some of this money to take Fani Willis on a number of exotic vacations to places like Aruba and Napa Valley.
And as a result of all these things, the lawyer argues both Mr. Wade and Ms. Willis and Ms. Willis’ entire office, which happens to be the largest prosecutor’s office in the state of Georgia, should all be disqualified from the case.
And the idea of disqualifying these prosecutors doesn’t just threaten the case against Michael Roman, it threatens the entire case against all the 15 remaining defendants, including Donald Trump. It really creates a scenario by which the case could just go poof. It could just go away.
OK, so putting aside for just a moment the accuracy of this allegation and the motion, can you just explain the legal questions that it raises? Why would a relationship between these two lawyers potentially disqualify them from the case and end up having the whole case potentially thrown out?
So Michael Roman’s motion makes the case. Essentially that the motives of the district attorney may be less than pure. That what motivates her every day when she wakes up and prosecutes this huge case is not just seeing through a prosecution in the interest of justice, but also the sense that there’s another motive that’s working in concert with it, which is to enrich herself, because her one time boyfriend was making all this money that her office is paying him, and that she’s using it to go on these vacations. And that somehow, her judgment is clouded. And as a result, the very process of justice is clouded.
Got it. So the allegation is that by hiring her boyfriend to work on the case, Fani Willis’s interest becomes not necessarily in properly prosecuting this case, but basically in keeping it going at all costs because it benefits her.
That’s right. So one of Michael Roman’s motions says that the more work that’s done on the case, regardless of what justice calls for, the more Fani Willis and Nathan Wade get paid. The more they fight his motions, the more they get paid. The more they refuse to dismiss defendants who should not be indicted, the more money they make. And that all of this amounted to a conflict of interest.
And of course, the more money the special prosecutor makes, Roman’s lawyer wrote, the more the district attorney gets to reap the financial benefits. So you get the idea, that there’s something there that is motivating her beyond just this pure quest to see that justice is done.
And what this motion seems to claim is that if this alleged relationship and the benefit that it brings to Fani Willis can be proven, then this entire case should therefore be thrown out.
That’s right. Although it’s worth keeping in mind that a number of legal scholars have argued that even if all of these allegations were true, there’s really no basis for this being construed as a conflict of interest. And that these prosecutors should stay on the case, and it should be steady as she goes from here on out. That this is all a big distraction that has no legal merit.
So what you’re saying is that no one’s quite sure that, legally speaking, there’s a real argument here to be made by Michael Roman. And if I’m remembering correctly, the feeling that a lot of people had when this motion was filed was that it was kind of a Hail Mary, right? And there was not much evidence that it was necessarily even true.
Yeah. Well, I mean, it was a Hail Mary in the sense that Michael Roman’s lawyer didn’t include any evidence to back up her claim, this very salacious claim. So there was a moment there when nobody knew really what to make of it. It was a very uncomfortable moment, given the nature of the allegations and given the seriousness of this case. And a few days after the initial filing by Michael Roman —
Good morning.
[CLAMORING]
Fani Willis gave a speech at an African American church in Atlanta.
First thing they say, oh, she going to play the race card now. But no God, isn’t it them who’s playing the race card when they only question one? Isn’t it them —
In which she portrayed this whole thing as a big witch hunt. She also insinuated that race was a motivation for this scrutiny of her and for Nathan Wade, both of whom are African American.
God, wasn’t it them that attacked this lawyer of impeccable credentials? The Black man I chose has been a judge more than 10 years. Is it that some will never see a Black man as qualified no matter his achievements? What more can one achieve? The other two have never been —
But then, a few days later, it looked like there was indeed some there there. It came out that there were some credit card statements that showed that Nathan Wade had bought tickets to vacation destinations for himself and for Fani Willis. So it started to look like this is more than just a figment of someone’s imagination. But Fani Willis and her office were convinced that there is really no legal basis for an affair to result in her being disqualified.
She files a motion that essentially acknowledges the affair. It included a sworn affidavit from Nathan Wade in which he said yes, there was an affair. It started in 2022 after I’d started working for the DA’s office in November 2021. But the argument was yes, there is some there there. However, Judge, there’s no need for an evidentiary hearing. Just looking at the law, there is no reason why this relationship between two consenting adults in their 50s should have any bearing on an election interference case involving a former president of the United States.
But another dramatic moment comes when the judge basically says, look, we’ve got to determine the contours of this thing. Because if these allegations were true, there is a possibility that this did constitute a conflict of interest or an appearance of a conflict of interest, which might be enough for him to disqualify these prosecutors. So he went ahead and he set the evidentiary hearing.
And the judge’s decision was a tremendous loss for Fani Willis and her office. And not only because she felt like this was an absolutely untoward and offensive intrusion into her personal life. But it also meant that this question was live. This question of whether or not there was some basis to disqualify her and her office and send what without question is the biggest case she’ll ever have to a place where we’re really not sure whether it’ll end up in a trial at all.
We’ll be right back.
So Richard, headed into Thursday’s evidentiary hearing, this highly anticipated legal session, what are the biggest questions that everyone’s looking for answers to?
Well, some of the biggest questions were laid out by the judge himself. And they all had to do with his interest in the extent to which there was some kind of financial benefit to these prosecutors as a result of this criminal case. The first question has to do with timing. Fani Willis and Nathan Wade have said their relationship started after November 2021, which is this key date when he begins working as a contractor for the Fulton County District Attorney’s Office.
Michael Roman’s lawyer, a lawyer named Ashleigh Merchant, had asserted that she was going to be able to prove that the affair started beforehand. And all this we think is of interest to the judge because it just looks different when you’re thinking about the question of self-dealing.
Did you hire a guy and this guy is someone you, after long hours at the office or whatever, you fell for and things progressed from there? Or was it somebody who was really already established as a boyfriend? And what you’re really doing is hooking up your boyfriend with a plum job. And so that was one key piece and one key question everyone had going in.
The second had to do more with the money as it pertains to the trips that Fani Willis and Nathan Wade took together. To Aruba, to California wine country. The prosecutors had claimed that they roughly split the costs of these trips. They didn’t provide a huge amount of evidence. They provided a little bit of evidence that seemed to hint at this idea. But the judge obviously wanted to see a lot more. And in fact, during the hearing, both of these issues were indeed quite big.
OK, so walk us through the most important moments of testimony, especially as they relate to these two key questions.
Thank you all. Please be seated. All right, we are on the record with 23 —
Well, the first issue, the timing issue, when did the affair start, was something that we thought was going to be answered, because Michael Roman’s lawyer said it was going to be answered, by a man named Terrence Bradley, who received a subpoena to testify.
Good morning, Mr. Bradley. How are you?
Not happy to be here, I’m assuming.
OK. I understand. Thank you for being here.
Wasn’t by choice.
Mr. Bradley is a former law partner of Nathan Wade’s. He also served for a time as Nathan Wade’s divorce lawyer.
When did Mr. Wade come to you to file the divorce action in Cobb County?
Your Honor, that’s privileged information.
But when Terrence Bradley took the stand, almost immediately he was met with a barrage of concerns from defense lawyers. And they threw up all these objections.
Are you aware of when their romantic relationship began?
Your Honor, I’m going to object. That relates to privilege. She says that he began —
Some of them on some technical legal grounds, some of them on this very specific technical legal ground that there was an attorney-client privilege that should prevent him from discussing anything having to do essentially with the affair.
And I have consulted with the bar. I cannot reveal anything that I saw or learned.
Mr. Bradley is sitting on the stand saying, look, I talked to the Bar Association. There’s really very little for me to do here. If I want to keep my law license, I need to just keep it zipped.
So Mr. Bradley, you may be excused for now. Thank you. We will call Mr. Yuri.
So as all this is unfolding and there’s a little bit of chaos in the courtroom and you can see that some people’s hackles are being raised, Michael Roman’s lawyer says, OK, well, I’m just going to call another person that I’ve served a subpoena.
Would you please state and spell your full name for the court?
Robin Beatrice Yeartie.
This is a woman named Robin Yeartie.
Can you tell the judge when you first met Ms. Willis?
In college.
Who is a former friend of Fani Willis.
And do you understand it that their relationship began in 2019 and continued until the last time you spoke with her?
And you were essentially her best friend during this time, right?
Not best friend, good friend.
Good friend. OK, close friend.
And she asserted that she knew Fanni quite well. And that Fanni Willis’s affair with Nathan Wade started before his start date of November 2021.
A pretty key piece of testimony that directly contradicts what Wade and Willis claim to be the starting point of their relationship.
Yes, she was very emphatic about this point.
You have no doubt that their romantic relationship was in effect from 2019 until the last time you spoke with her.
So it was obviously a very dramatic moment. And it of course, raises the question of whether or not someone is lying.
Another thing that Ms. Yeartie’s testimony did was it gave the defense attorneys the ability to call their next witness to the stand.
Please state and spell your name for the court.
My name’s Nathan Wade.
Who was none other than Nathan Wade himself.
When did your romantic relationship with Ms. Willis begin?
When in 2022?
Early 2022.
So Nathan Wade takes the stand and he continues to insist that the romantic relationship between him and Fani Willis began in 2022 after he’d been hired by her to do. The Trump case. But a lot of his testimony centered around questions about whether or not she had paid him for roughly half of all of these trips.
What I allege is that our travel was split roughly evenly. So where you see I have booked a flight or I’ve paid for a flight with my credit card, what you don’t see is that she covered her own flight reimbursement to me.
So this roughly sharing travel, you’re saying she reimbursed you.
And where did you deposit the money she reimbursed you?
That was cash. She didn’t give me any checks. So she paid you cash for her share of all these vacations.
Mr. Schaefer, you’ll step out if you do that.
He claims that Fani Willis repaid him for a number of these travel related vacation expenses in cash. In fact, everything got repaid in cash.
2023 December, you said you didn’t have any receipts.
I do not have any receipts, I did not have any receipts.
But you did travel with Ms. Willis.
He also said at one point that he didn’t have any deposit slips that showed that he’d received the cash and then deposited it. That she was somebody who was an independent woman. It was very important for her to make sure that they more or less went Dutch on stuff. And that the way she did it was not through an app. It wasn’t by writing a check. It wasn’t Venmo. It was with physical American currency.
So Wade is saying this was all on the up and up. Fani Willis, his girlfriend at the time, was paying for half of everything. But he can’t prove it because she’s paying him back in cash. And he doesn’t have any records of depositing that cash.
Yeah, that’s right. And as you can imagine, this was received with something like extreme incredulity from the defense lawyers.
And she paid you cash for both of your portions or just hers?
OK. So that trip Belize — just Belize — she paid you for everything on Belize.
The entire trip.
OK. So the —
And of course, to the defense lawyers, all this felt a little bit too convenient. The fact that these cash payments of course, would have no record to preserve that they actually happen.
Right. So at this point — and Richard, I was watching some of this testimony. Things are not going super well for Fani Willis or Nathan Wade. We’ve got this witness saying, the relationship between the two of them started earlier than either has acknowledged. We have no records that Fani Willis reimbursed Wade. It’s rough sledding.
That’s right. And —
All right. Ms. Merchant, any other witnesses.
Yes. We would call Fani Willis to the stand.
In the middle of all this steps, Fani Willis.
We would ask the court that the court allow Ms. Willis to be called and interrogated on these matters.
And I would too, Your Honor.
Who walked unaccompanied through the front door of the courtroom.
I’m ready to go.
And she said something to the effect of, let’s do this. And she said at a time when her lawyer was trying to argue to the judge that there was no reason why her testimony should even be necessary. But she really made this dramatic decision to go ahead and put herself on the stand.
Ms. Willis, when — how did you know to come into the courtroom right then?
There were people that was pacing in my office.
And I heard someone yell, his testimony is done. It only made sense to me that I would be your next witness. And I’ve been very anxious to have this conversation with you today. So I ran to the courtroom.
So as soon as —
It was very much in keeping with Fani Willis and her personality, which is extremely big. So she is confronted by Ashleigh Merchant, the lawyer for Michael Roman. And these two women have this very intense faceoff.
Let’s start back in 2019. So you and Mr. Wade met in October of 2019 at a conference.
That is correct. And I think in one of your motions, you tried to implicate I slept with him at that conference, which I find to be extremely offensive. I stayed —
And from the get-go, it’s obvious that Fani Willis is extremely angry.
And keep the answers confined to the questions as best you can I think you’ll have more than enough ample opportunity on — when the state — was it able to highly offensive when someone lies on you, and it’s highly offensive when they try to implicate that you slept with somebody the first day you met with them. And I take exception, too.
All right. Well —
And it was just a searing a series of moments.
No, no, no, no, this is the truth.
Ms. Willis, Mr. Mr. Santana, thank you. We’re going to take five minutes.
And the judge, Judge McAfee, basically shut the proceedings down for about five minutes, which was very judge McAfee thing to do. He’s a very even-keeled judge. And you could tell he needed to just put a damper on things and give everybody a chance to to, including, Fani Willis, to just cool down.
And what do we end up learning from Fani Willis dramatic testimony here about some of the key questions. Well, we have been talking about. Well, one of the most important things we learned from Fani Willis testimony was that she is going to stick to her story and Nathan Wade’s story.
And you all start. When did you start dating? When I started dating, Mr. Wade it was right around then.
April 2020 — 2? 22, yes.
2022. That their romantic relationship really only blossomed in 2022.
It’s not like when you’re in grade school and you send a little letter and it says will you be my girlfriend and you check it. I don’t know if day that we started seeing each other, but it was early ‘22 is my recollection.
After, she hired him to work on the Trump case.
I would say we had a tough conversation in August.
She also told us that they stopped dating sometime around the summer of 2023 before the Trump indictment was handed up.
So let’s just back up and talk about the first time that you went to Florida with Mr. Wade. That was the time that you said you stayed in Miami at the hotel —
And there was also this really interesting conversation about the fact that it was Nathan Wade who had put so many of these travel related charges on his own credit card.
So yes, he is the original one that does it. Mr. Wade is a world traveler. I’m not as versed as him. He’s been to six of the seven continents. And so he has both a personal travel agent. And he also has a cruise traveler.
She said that he’s a world traveler, that he’s really — in that relationship, he was the guy who was more experienced and in setting up travel plans and paying for them.
I know he initially paid for it.
Did you pay him back?
For the cruise and for Aruba, yeah, I gave him his money before we ever went on that trip. You gave him cash before you ever went on the trip?
OK. And so when you got cash to pay him back on these strips, would you go to the ATM? No, lady. You would not go to the ATM. No. And then there was also a really interesting conversation about why she relied so much on cash to reimburse him for some of these travel expenses. So the cash that you would pay him wouldn’t get it out of the bank
I have money in my house.
You have money in your house. So it was just money that was there.
When you meet my father, he’s going to tell you as a woman, you should always have — which I don’t have, so let’s don’t tell him that. You should have at least six months in cash at your house at all time. Now I don’t know why this old Black man feels like that. But he does. When we was growing up —
Her argument, was it? It was really based in a lot of things that her father who she’s very close to and who really played a very big role in raising her passed on to her. Which is that you need to have a certain amount of cash around on you. If you’re a woman and you go on a date with a man, you better have $200 in your pocket. So if that man acts up, you can go where you want to go.
There is an empowering element of this that he taught her.
It’s interesting that we’re here about this money. Mr. Wade is used to women that — as he told me one time, the only thing a woman can do for him is make him a sandwich. We would have brutal arguments about the fact that I am your equal. I don’t need anything —
Ms. Willis also made it clear that in this romantic relationship, there was no question that she wanted to be treated as an equal. And she, in fact, called out Mr. Wade for some sexist ideas that he had.
Which is why I always give him his money back. I don’t need anybody to foot my bills. The only man who’s ever foot my bills completely is my daddy.
And when you heard this coming from her or at least when I heard it coming from her, you had this coherent idea of why somebody like Fani Willis would be so reliant on cash. And it also served in a way to buttress what Nathan Wade had just said. The fact that she was a person who paid him back in this way. And listening to it, I went from a sense of, OK, well this sounds bizarre that you would just show up at your boyfriend’s house with an Adidas bag stuffed with bills. To something that’s more like, well, OK, this is plausible. This is something that’s been passed down.
And it’s something that you could maybe — I can’t verify it, but it just seems like something that would be plausible in this moment when cash is on the way out for some people. But for some other people, it really feels like an empowering tool.
Right. And in the end, she doesn’t give an inch on these questions of when the relationship started and whether she benefited from it.
That’s right, she stuck to her guns. And she also had a really dramatic moment where she tried to remind everyone who was following along that she was not on trial.
So your office objected to us getting Delta records for flights that you may have taken when Mr. Wade —
Well, no, no, no. I object to you getting records. You’ve been intrusive into people’s personal lives. You’re confused. You think I’m on trial. These people are on trial for trying to steal an election in 2020. I’m not on trial no matter how hard you try to put me on trial.
So my question —
She said it was the people who tried to overturn the election who were on trial. And that was one of the moments that really sent a real shock through the courtroom. You have this melodrama, this footnote that’s now ballooned into its own story. And it was a very interesting moment of redirecting the flow of the conversation back to very fundamental questions about democracy and efforts to subvert it.
You can sit down. You’re done for the day.
You want me to leave the courtroom.
Or you can sit at the counsel table. We don’t need you in the witness box.
Richard, by the end of this testimony. Yortie, Wade, Willis — a pretty complicated portrait has emerged of this relationship that’s now at the center of these questions of whether this case involving democracy moves forward. I mean, this one witness says the relationship starts before Willis hired Wade. But it’s just her word. There’s no hard evidence. And Wade and Willis under oath disagree.
It becomes clear that we did pay for a lot of travel for Willis. And yet, Willis says she reimbursed him, but there’s no evidence that either of them can produce to verify that. So there aren’t really smoking guns in either direction.
Yeah, I think that’s right. I mean, what we do know is that we’re going to have a lot more testimony we’re going to have more witnesses who will probably be called but I do think that this has given Donald Trump and his allies the ability to create a kind of plume of suspicion that there were bad intentions behind this case. And I think we should think about what the real practical ramifications of that issue are. And by an issue, I mean a public relations loss for the district attorney’s office.
It has a real potential material effect because the jury that sits to decide whether or not Donald Trump broke the law in Georgia will come from Fulton County. And if they continue to read headlines that say that something is fishy about that Fani Willis and her boyfriend or ex-boyfriend and their travel, you could potentially see a greater possibility that at the very least, one of those 12 future jurors decides that something is too fishy for them to vote guilty.
And in that way, this entire drama is extremely relevant no matter what the judge rules in the coming days.
In other words, no matter what the judge decides, whether he keeps them on the case or disqualifies Willis and Wade, something about this case in its fundamental mission has been altered here. And maybe weakened.
I think that’s possible. And one of the things I find so remarkable is that we’ve all thought of the Georgia case as one that really couldn’t be touched by Donald Trump if he were to be re-elected. He couldn’t pardon himself. He couldn’t direct his future attorney general to dismiss the case.
And yet, here we are with this threat to the Georgia case that’s coming from a very different place.
That’s coming from what some people would argue would be a lapse in judgment. It’s almost unfathomable to imagine that a history could be bent by something like that. But here we are.
[MUSIC PLAYING] Well, Richard, thank you very much. We appreciate it.
Thank you, Michael.
The hearing is scheduled to resume this morning, with Fani Willis expected to return to the stand. A ruling on whether she and Nathan Wade should be removed from the case is expected in the next few weeks.
Here’s what else you need to know today. A judge in New York has officially scheduled the first criminal trial against Donald Trump to begin on March 25th, ensuring that the former President will face at least one jury before election day. That trial, led by the Manhattan district attorney, will focus on allegations that Trump falsified business records during his 2016 presidential campaign in order to hide a sexual relationship with an adult film star.
And police in Kansas City said they believed that a dispute between teenagers was the cause of a mass shooting at a Super Bowl victory celebration that injured nearly two dozen people and killed a 43-year-old woman. Police identified that woman as Elizabeth Galvin, a local DJ whose son was also shot in the leg during the gunfire.
Today’s episode was produced by Rob Zipco, Sydney Harper, and Alex Stern. With help from Rachelle Bonja. It was edited by Devin Taylor, contains original music by Dan Powell and Marion Lozano, and was engineered by Chris Wood. Our theme music is by Jim Brunberg and Ben Landsverk of Wonderly. Special thanks to John Ketchum.
That’s it for The Daily. I’m Michael Barbaro. See you on Monday.
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	1.1: Chapter 1
Make certain all of your pages are ordered and numbered correctly. 4. The usual business plan convention is to number all major sections and subsections within your plan using the format as follows: 1. First main heading. 1.1 First subheading under the first main heading. 1.1.1.




	PDF HOW TO WRITE A BUSINESS PLAN
1. Internal: Providing management and staff with a clear map, complete with signposts and milestones against which progress can be monitored and evaluated. 2. External: Presenting the investment case to an outsider. This key function provides the focus for this note. Essentially, business plans are sales documents.




	Full article: Theories and Planning Theories
Quite a few JAPA articles assess plans and ask larger questions about existing models and processes. For example, Loh and Kim (Citation 2021 /this issue) examine equity content in local comprehensive plans proposing strategies for improving practice. Planning ethics is both a core part of planning theory and a major theme in JAPA.




	11.4 The Business Plan
The full business plan is aimed at executing the vision concept, dealing with the proverbial devil in the details. Developing a full business plan will assist those of you who need a more detailed and structured roadmap, or those of you with little to no background in business.




	The road to entrepreneurial success: business plans, lean startup, or
Typically, business planning has been analyzed as the single act of writing a business plan (e.g. Honig and Karlsson, 2004).However, business planning is made up of a variety of activities (Gruber, 2007), which entrepreneurs may utilize as a whole, or simply choose parts of the business planning process.It is worth noting that these specific activities are not mutually exclusive with lean ...




	PDF Business Plan Guide for pdf
MASSACHUSETTS SMALL BUSINESS DEVELOPMENT CENTER NETWORK BUSINESS PLAN GUIDE A structured guide with worksheets to assist you in the development of your business plan, financial projections, and operating budget. Adapted from materials written by Donald J. Reilly Southeastern MA Regional Small Business Development Center 200 Pocasset Street




	(PDF) Importance And Contents Of Business Plan: A Case-Based Approach
(PDF) Importance And Contents Of Business Plan: A Case-Based Approach CC BY-SA Authors: Ruqayah Abdullah Abstract and Figures Planning and business plan, as a its product represent...




	PDF Entrepreneurship and the Business Plan
The theory presents the relevant information that has to be considered inside the firm. After the theory a business plan was created with the objective of setting the direction of the company over the next years. It is important to mention that business plans are evolving documents that have to be updated according to changes in the environment or




	PDF The Business Model: Theoretical Roots, Recent Developments, and ...
Specifically, 1) the business model is emerging as a new unit of analysis; 2) business models emphasize a system-level, holistic approach towards explaining how firms do business; 3) organizational activities play an important role in the various conceptualizations of business models that have been proposed; and 4) business models seek to




	Business Plan
Abstract: The following are the Learning Objectives: Understand the functions of a business plan. Recognize the content of business plans in the market. Understand the primary purposes of a business plan for financing. Understand the details when the entrepreneurs write business plans. We recommend




	What Is a Business Model?
Businesses make assumptions about who their customers and competitors are, as well as about technology and their own strengths and weaknesses. Joan Magretta carries the idea of assumptions into her...




	(PDF) The Business Model and Business Plan
Por su parte, el plan de negocios es una herramienta de planificación para la creación de empresas, que plasma en un documento las operaciones comerciales y técnicas planeadas, así como los...




	Fundamentals of Business
Chapter 1 Teamwork in Business Chapter 2 The Foundations of Business Chapter 3 Economics and Business Chapter 4 Ethics and Social Responsibility Chapter 5 Business in a Global Environment Chapter 6 Forms of Business Ownership Chapter 7 Entrepreneurship and Small Business Development Chapter 8 Management and Leadership




	(PDF) Management and business plan
Findings: This chapter suggests that a well-designed business plan can help prospective entrepreneurs to (1) facilitate their decision-making, (2) minimise their risk perception, and (3)...




	PDF MULTIPLE EFFECTS OF BUSINESS PLANS ON NEW VENTURES
Business plans are a prevalent feature of new venture management and are encouraged by government agencies, education institutions and consultants. They are frequently a core input to seeking loan and equity finance. There is also a widespread belief that writing a business plan will impact favourably on the performance of a venture.




	PDF Case Study: Company X
A business plan can either provide stablility and prosperity to a company or drastically worsen its state. Thus, the recommendations for ... framework presents the theory that will form the theoretical foundation of the thesis. 1.1 Research Background In September 2016, the author carried out her internship in the business ...




	(PDF) The Complete Book Of Business Plans Simple Steps To Writing
An analysis of the empirical research on Russia's post-Soviet religious situation reinforces the author's argument that an uncritical theory of the subject attends only to the superficial layers of the subject, which end up being devoid of actual subjectivity, according to Lacanian logic.




	(PDF) A Hedge Fund Business Plan: Investment Theory, Operations, and
A Hedge Fund Business Plan: Investment Theory, Operations, and Capital Raising for Broadgates Capital Management By A4IP Ajay Pal Singh Launching a start-up hedge fund is a complex, multifaceted endeavor that requires an understanding of the interconnectivity between capital raising, investment strategy, regulation, and fund operations.




	Business Plan Theory
Business Plan Theory Uploaded by Naishadh Bhatt A Business Plan is a document used to raise money, obtain credit, perhaps recruit management or directors. Davidson and Company LLC Explains the opportunity in the market, product or service, and potential profits for investors.




	(PDF) Business Model Theory and Research: A Philosophical Discussion
Business Model Theory and Research: A Philosophical Discussion Authors: Arash Najmaei MGSM, ACU and ICMS Zahra Sadeghinejad Business model concept is increasingly receiving attention of...




	Home Care Business Plan PDF Example
Creating a comprehensive business plan is crucial for launching and running a successful home care business. This plan serves as your roadmap, detailing your vision, operational strategies, and financial plan. It helps establish your home care business's identity, navigate the competitive market, and secure funding for growth.




	How to Write a Food and Beverage Business Plan + Sample Business Plan PDF
Writing a business plan is an easy first step that you can start for free. Plus, businesses that take time to plan are significantly more successful than those that don't. Many food and beverage establishments fail because of one of the following: Poor inventory management; Underestimated expenses; High employee turnover; Misjudged the size ...




	PDF Equity Action Plan Summary: U.S. Small Business Administration
2023 Equity Action Plan Summary: U.S. Small Business Administration. New strategies to advance equity. 6. 5. Improve access to investment capital. Small businesses and startups




	PDF Equity Action Plan
dramatically lower figure. Awards through the HUBZone and 8(a) Business Development Program set asides were even lower. Alternatively, the last tier on VA's set-aside hierarchy received the second highest volume of dollars; $461 million were awarded through the general small business set-aside. These data illustrate two factors.




	(PDF) Development of Business Theories
Jan 2022 Rosemary Jotham Mukama View PDF | Business theories are proposed laws or principles that can be used to describe markets, competition, innovation and organizational culture. The... |...




	Create a form in Word that users can complete or print
Show the Developer tab. If the developer tab isn't displayed in the ribbon, see Show the Developer tab.. Open a template or use a blank document. To create a form in Word that others can fill out, start with a template or document and add content controls.




	(PDF) ENTREPRENEURSHIP AND BUSINESS PLAN
An entrepreneur is a person who sees or creates an opportunity, brings together the factors of production for the purpose of establishing a business, produces or markets a product/service, is...




	An Explosive Hearing in Trump's Georgia Election Case
Fani T. Willis, the district attorney, defended her personal conduct as defense lawyers sought to disqualify her from the prosecution.
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